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Introduction 

The Awning Composer team is pleased to announce the latest release of Awning Composer 
featuring an extensive set of customizable dynamic objects.  This is part of a continuing 
development effort incorporating ideas and feedback from fabricators to add functionality that 
will help them grow their business.  To see a complete list of changes and additions to the 
software, please visit the Development Log page at www.awningcomposer.com. 
 
Please note that Awning Composer 5 was designed to use the graphics hardware that is 
installed in your computer.  However, if your computer is old, has outdated graphics hardware 
or graphics drivers that are not up to date or not functioning, then Awning Composer 5 may 
not work on your system.  You may need to update your computer or use version 4 instead.  
For more information, please visit the System Requirements page on the website. 
 
Awning Composer 5 is also compatible with a variety of Windows-based tablets.  This provides 
a whole new way for you to interact with your customer using your fingers instead of a mouse 
to create a rendering.  Please contact Awning Composer Support for recommendations before 
purchasing a tablet. 
 
We encourage you to continue to provide us with your feedback on Awning Composer.  We 
welcome your input and suggestions as we can continue the development process to build 
Awning Composer into the ultimate tool to support your business needs.  You can send us your 
feedback using the convenient feedback form built into Awning Composer.  To do this, click 
the Send Feedback button on the Help page of the File tab. 

Notes for Users of Previous Versions 

Awning Composer 5 features significant improvements as well as many new features.  
However, some features from previous versions are not available in version 5: 
 

 3D text 

 Curved text 

 Backdrop editor 
 
If you find yourself needing any of these features, we encourage you to either use image editing 
software (see our Software Recommendations page on the website) along with Awning 
Composer 5, or use Awning Composer 4 on an as-needed basis.  Versions 4 and 5 can both be 
installed at the same time and do not conflict with each other. 
 
Please also note that the software license for Awning Composer has been changed to a 
company-wide license.  This means you can install Awning Composer on all of the computers 
within your organization at no extra charge.  Just use the same company name and serial 
number on each computer. 
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User Interface Overview 

Compatible with widescreen displays and tablets and has a scaled work environment 
 
Awning Composer 5 incorporates ideas and feedback collected from hundreds of fabricators 
over the years.   
 
All program functions support the entry of actual dimensions, which allows fabricators to work 
in a realistic environment so awnings and fabric patterns can be shown on a building to scale. 
 
The window layout was specifically designed for widescreen displays and the large buttons 
make it easy to use on touch-screen tablets.   Here’s an overview of the different sections of the 
main program window: 
 
 
 
  

 

Ribbon that organizes commands into 
groups. 

Environment section that contains detailed 
info about the objects, background, lighting or 
camera depending on the tab that is selected 
at the top of this section. 

Properties section that allows changing 
the properties (such as size) of the 
selected object. 

Status bar that shows the current input “mode” along 
with a list of valid mouse commands. 

Tabs that logically organize program functions.  

Quick access toolbar for commonly used functions. 
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Graphics Overview 

Provides support for high quality output and advanced features such as shadows 
 
Awning Composer uses a new graphics engine that utilizes the graphics hardware built into all 
modern computers to provide high quality output and faster rendering.  Please note that 
results may vary based on your computer graphics hardware. 
 
In addition, awnings can cast shadows that can be adjusted based on the position of the light 
(i.e. sun).  In the picture below, the light was set to be shining down from the upper left hand 
corner of the scene: 

 
Awning Composer can also calculate the sunlight angle based on the building location, the 
direction the building is facing, time of year and time of day.  For more information, please see 
the section titled “Sky and Automatic Lighting”. 
 

Note: Awning Composer 5 was designed to use the graphics hardware that is installed in your 
computer system.  However, if your system is old, has outdated graphics hardware or 
graphics drivers that are not up to date, then version 5 may not work on your system.  In this 
case, you may need to update your system or use version 4 instead. 
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Backdrops 

Working with backdrop photos 
 

Angled Backdrop 

The first step in creating a new scene is setting the backdrop.  You can use any photo of a 
building, but your options will vary depending on how the photo was taken.  When taking 
photos at an angle, it’s best to use a close-up shot at a moderate angle to allow the front and 
sides of the awnings to be visible, giving the awnings a 3D appearance: 

In addition to angled backdrops, Awning Composer also has special support for photos taken 
from a distance with a straight-on view.  These straight-on backdrops have several advantages 
over angled backdrops: 

1) The backdrop can be scaled using the distance between two points in the picture with 
known dimensions such as the height of a door or a window. 

 
2) The distance between any two points on the backdrop can be measured using a built-in 

electronic tape measure and the backdrop can be viewed from any angle or distance. 
 

3) “Invisible 3D ground” can be added so it accurately projects the shadow cast by the 
awning on the “actual ground” shown in the picture. 

 
4) The awning, valance and fabric can be designed to scale on the backdrop using actual 

frame dimensions and actual fabric repeat values. 
 

5) The backdrop can be cropped to remove the sky and a computer generated sky can be 
added that reflects the actual sky conditions at any specified time of day. 
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Straight-on Backdrop 

When a new backdrop image is brought into the program, Awning Composer will allow you 
specify if it is an angled or straight-on view.   
 
If angled view is selected, the backdrop will be brought into the program where awnings can be 
superimposed on it, but the camera angle is fixed and the backdrop cannot be scaled.   
 
If straight-on view is selected, the program walks you through the process of specifying the 
scale of the image the size of an item in the picture.  IMPORTANT:  Be sure to use the size of an 
item that is on the same plane where you are placing your awnings.  If you use the height of a 
door that is set into an alcove to measure window awnings, your measurements could be 
wrong.  In this case, it would be better to measure one of the windows to set the scale. 
 
The program also gives you the option to add three dimensional ground and adjust the 3D 
ground position so it matches the actual ground in the image.  3D ground is shown as a flat grey 
plane that intersects the backdrop picture at a 90-degree angle to create the illusion of ground 
in the scene.  Once the ground is adjusted, it can be made “invisible” by selecting “Invisible 
(shadows only)” in the drop down box in the Background tab.  Even though the ground is 
invisible, it will still reflect shadows from any objects in the scene, making the shadows look 
more realistic. The background behind the backdrop can be set as sky, a solid color or 
transparent. 
 

Note:  Once the user has defined an image as angled or straight, Awning Composer 
“remembers” that designation and scale whenever the backdrop is opened, even if it is not 
part of a scene.  However, these settings can be changed at any time using the Backdrop tab. 
  

Option to choose 
sky, solid color or 
transparency 
behind backdrop 

 

Option to make 3D ground invisible 

3D Ground 
Straight-on 
backdrop image 

Option to change backdrop type (angled or straight) 

Option to choose 
sky, solid color or 
transparency 
behind backdrop 

Option to choose 
units of measure 
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3D Angled Backdrop  

Even though straight-on backdrops offer many advantages over angled backdrops, sometimes 
it’s just not feasible to use a straight-on photo.  One common example is a building that 
requires a corner awning.  To work with this kind of photo, you can set the backdrop to be an 
angled backdrop and be subject to the limitations of angled backdrops as described in the 
previous sections, or you can set the backdrop to be a 3D angled backdrop. 
 
3D angled backdrops work like a middle ground between straight-on and angled backdrops.  
The photo is positioned on a flat plane in 3D space, similar to a straight-on backdrop, but 3D 
objects can pass through it into the distance without disappearing behind the building, similar 
to an angled backdrop. 
 
To set a backdrop as 3D angled, first open the photo as a straight-on backdrop.  Then go to the 
Backdrop tab and change the backdrop type to 3D angled. 
 
You can set the scale of the scene using the camera distance and FOV controls, the “Set Scale” 
command typically used for straight-on backdrops, or some combination of those two methods.  
However, note that with the “Set Scale” command, as you get further away from the object in 
the photo that you used for scaling, the less accurate your measurements will become.  To 
achieve a convincing look, you may need to set the object dimensions to somewhat unrealistic 
values.  Avoid using production-oriented functionality such as the Parts List in such cases. 
 
Before adding awnings to the scene, be sure to set the camera angle and distance to what you 
would like them to be when you do your final rendering.  Once you add awnings to the scene 
and adjust their size, you will not be able to change the camera angle or distance because it will 
change the perspective and perceived size of the awnings. 
 
Here’s an example rendering created using a 3D angled backdrop: 
 
 
 
 

  

Original picture: 

 
 

Rendered picture: 
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Basic Camera Controls 

Zoom, pan and rotate features allow objects to be seen from any angle 
 
One of the most powerful new features of Awning Composer is the ability to adjust the camera 
angle and position.  These camera controls are only available for straight-on backdrops or 
when there is no backdrop. 
 
Think of these camera controls as the ability for you to “fly” around the scene and view it from 
any angle; above, below, from the side or even from behind.  With practice, controlling the 
camera can be done in any mode using various mouse buttons.  But sometimes it’s easier to 
use the camera controls on the ribbon as shown below: 
 
 
 
 
 
 
 
 
 
 
 

 
By clicking on one of these icons, the program is put into a specific camera mode, making the 
camera easier to control by using the left mouse button (or touch): 
 

Pan Camera Mode Hold down the left mouse button and move the mouse to pan the 
camera, moving it left, right, up, or down within the scene.  The 
contents of the scene will appear to shift in the opposite direction of the 
camera movement. 

Rotate Camera Mode Left click on an object to center the camera on that object or middle 
click anywhere in the 3D view.  A green ball appears and represents the 
center point that the camera rotates around.  Hold down the left mouse 
button and move the mouse to rotate around the center.  You can also 
use the arrow keys to rotate around the center point. 

Look Around Mode The camera rotates around its current position allowing you to look 
around from a fixed location.  Hold down the left mouse button and 
drag to rotate the camera.  Use the mouse wheel to move the camera 
forward or back, or use the WSAD keys. 

Zoom Camera Mode Hold down the left mouse button and move the mouse up or down to 
move the camera closer to or further away from the contents of the 
scene. Shortcut: You can also press the “C” key to zoom in and out. 

Reset Camera Resets the camera to a default position and orientation suitable for 
viewing the entire contents of the scene. 

Helpful keyboard command:  You can use the “/” key to center the camera on any object part 
that has been highlighted in the Environment Section or in the 3D view. 

 

Zoom Camera 

Rotate Camera 

Look Around 

Reset Camera to 
starting position 

Pan Camera 
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Example of Camera Rotation 

The screen shot below shows an extreme example of camera re-positioning.  The camera has 
been rotated so it is looking at the backdrop from the left side.  The awning is shown 
“attached” to the backdrop and the shadow from the awning is being reflected by the 
“invisible” ground. 

 
 

Using the camera controls, you can zoom in and out and view the scene from any angle.  To 
produce a convincing rendering, start by viewing the building (and awnings) straight-on.  Then 
rotate the camera slightly to the side and zoom in enough so that the sky (behind the backdrop) 
is not visible, or is only slightly visible. 
 
The camera controls also allow you to show your customers multiple views of the scene from 
close in or far away perspectives and from various angles. 
 
Note:  To get the best results, we recommend taking a high-resolution photo of your 
customers building straight-on with some sky above the building and some of the parking or 
street area in front of the building. 
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Shadow and Scene Lighting 

Controls shadows and amount of light in the scene 
 
The shadow option can be turned on/off for an entire scene or for an individual object (i.e. 
awning).  For any shadows to be cast in the scene, the “Enable Shadows” checkbox under the 
Lighting tab must be checked.  Un-checking this box will turn off the shadow option for all 
objects, regardless of their individual shadow settings. 
 
In addition to the shadow option for the scene as a whole, each object has its own control for 
shadowing.  Select an object in the scene and then click on the “Object” tab.  If the “Shadow 
Visible” checkbox is checked, then this object will cast a shadow, otherwise it will not. 
 
Shadow intensity is controlled at the scene level through a “Strength” slider. 
 
Scene Lighting: The amount of light in the scene can be controlled manually or automatically.  If 
the “Auto” option is enabled, the objects in the scene will get lighter as the sun rises and darker 
as the sun sets.  If the “Affect backdrop/ground” option is enabled, the backdrop and ground 
will be affected by the scene lighting levels.  The first time you use any of the controls in the Sky 
tab, these two switches will automatically be turned on.  If you turn them off, then you must 
manually turn them back on. 
 

 

“Enable shadows” checkbox (under the Light tab) 
controls shadowing for the entire scene. 

“Shadow visible” checkbox (under the Object tab) 
controls shadowing for the selected object. 

“Strength” slider controls shadow 
intensity for the entire scene. 

Scene lighting controls can be used to set the amount 
of light in the scene manually or automatically. 
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Adding Objects 

Categories are displayed horizontally, drag and drop feature 
 
After clicking the “Add Object” button in the ribbon, the following window is displayed: 

 
Objects are organized by category using tabs across the top.  Some categories contain 
additional grouping using headings.  The Stationary tab shown above contains two types of 
objects: dynamic objects and pre-modeled objects.  Dynamic objects (gray and white objects) 
are fully customizable and include frame components while pre-modeled objects (color objects) 
have no frame and only allow adjustments to width, height and depth. 
 
To add an object to the scene, double-click on the object.  The object will appear in the center 
of the 3D view and the “Add Objects” window will disappear. 
 
Objects can also be added to the scene by left clicking and holding on the desired object and 
dragging the object directly into position within the scene.  To replace an object, be sure the 
target object to be replaced is selected, then click the “Replace Selected” box in the upper right 
hand corner and then add the new object to the scene. 
 
To keep the “Add Objects” window from disappearing, click on the small “push-pin” located 
next to the “X” in the upper right hand corner.  When the push-pin is shown vertically, then the 
window stays visible (or pinned) until the window is closed by clicking “X” or “Add Object”. 
 
The Corners tab contains corner objects for several awning styles.  Shown below are all the 
available corner objects for a Traditional awning: 

 
While one object is selected in the scene, add another object to automatically connect the two.  
For more information on how to use these objects to create compound awnings that fit around 
corners or over walkways, refer to “Corners and Connected Objects” in the “Dynamic Objects” 
section. 
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Shade Sails 

The “Shade Sails” tab contains some sample shade sail designs.  These objects are brought into 
the scene as a single object with fabric and poles making it easy to position it within the scene.  
If adjustments to an individual pole are needed, you can use the “Split” command to separate 
that pole into its own standalone object, make the adjustments, then “Recombine” the pole 
back into the shade sail object.  (See Splitting Object Parts and Grouping and Combining Objects 
for details.) 
 
 
 
 
 
 
In addition to the pre-built sample shade sails, there is also an interface to MPanel Shade 
Designer, a separate application.  This interface provides an easy way to create a custom shade 
sail with up to six points.  The main advantage over the sample shade sails is the ability to 
specify the exact dimensions for a job so the shade sail fits the topography of the job site. 
 
A special version of MPanel Shade Designer is available at no charge to licensed Awning 
Composer V5 customers.  To get it, simply sign into your account at www.awningcomposer.com 
and click on the “Download MPanel Shade Designer” link.  Once MPanel Shade Designer is 
installed, start Awning Composer and double-click on the “Create in MPanel Shade Designer” 
icon in the Shade Sails tab.  This will open MPanel Shade Designer. 
 
Once you’ve entered information into the various tabs of MPanel Shade Designer, go to its 
Calculate tab and press the Calculate button.  After a successful calculation, click on the “Return 
to Awning Composer” button to bring your custom shade sail back into Awning Composer.  
 
 
 

  

 

 

Specify 3, 4, 5 
or 6 points 

Input fabric dimensions. 
For example: 16’ 10.7” 

Input pole heights. 
For example: 9’ 10.1” 

Click “Next” and then click 
“Calculate” and you are done! 

http://www.awningcomposer.com/
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Shade Sail Shadows 

Unlike awnings which normally cast shadows on buildings, most shade sail applications will be 
casting a shadow on the ground.  In this case it is best to use an angled backdrop.  Since Awning 
Composer does not know the angle that the picture was taken, it will draw the shadow on a 
plane that is aligned with the bottom of the object in the scene.  For a shade sail, the shadow 
will be lined up with the bottoms of the poles that are holding up the shade sail. 
 
To make the shadow look more realistic, rotate the shade sail so it matches the angle of the 
picture.  This can be done by locking the X, Y or Z axes and using the arrow keys to rotate the 
object.  Once the bottom of the poles are lined up at the same angle as the picture, use the 
“Rotate Light” or “Sky” features to match the sun angle in the picture. 
 
 
 

 
  

 

 

This image shows a 5-point 
shade sail just after it was added 
to the scene. 
 
Note that the bottoms of the 
poles are not aligned with the 
angle of the picture.   In this 
case, the back of the shade sail 
needs to be rotated up. 

This image shows the same shade 
sail after it was rotated on the    
X-axis to match the angle of the 
picture. 
 
The shade sail was also moved 
back along the Z-axis so it is 
covering the far end of the pool. 
 
In the “Sky” tab, the shadow from 
the shade sail was adjusted to 
match the shadows in the picture 
by setting the time of day to 
3:00pm on July 1st and setting 
the compass direction that the 
photo was taken to “N”. 
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Selecting and Hiding Objects in the Scene 

Using two point-and-click features and visibility controls 
 
To select an object (i.e. awning), simply left click on the object and the X, Y and Z axes will 
appear from the center of the object.  Also, the name of the selected object is highlighted on 
the left side of the screen in the “Objects” tab. 
 
To select an individual part of an object (e.g. top, left side, right side, valance, text, etc.), point 
to the specific part and click the middle mouse button.  Or, click on the part’s name.  Next to 
each item listed in the objects tab is an “eye” that determines if that item is visible.  If the eye is 
open, then the item is visible. If the eye is closed, then the object is hidden.   
 
 
 
 
 

In the example below, the sides of the traditional awning are hidden as indicated by the closed 
eye next to the part names “Left” and “Right”:  
 
  

 

Highlighted name indicates front 
of Traditional awning is selected. 

Closed “eye” indicates that right and left 
sides of traditional awning are hidden. 

Selecting in the Scene Window 
Left click = Select object and all 
its parts. 
Middle (wheel) click = Select 
an individual part. 
 

Open eye = item is visible 
 
Closed eye = item is hidden 
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Moving Objects 

Using the mouse, arrow keys, numeric amounts, axis locks and movement plane 
 
There are three ways to move an object within the scene: using the mouse, using the arrow 
keys or by entering numeric amounts.  Object motion can be limited to certain directions using 
the X, Y and Z axis lock controls.  There is also a movement plane setting that controls whether 
objects move along the surface of the building or the ground when no axis is locked. 

Movement Plane 

The movement plane setting is located in the object properties.  For awning objects, the default 
setting is “Building”.  This means the object will move along the front of the building when 
moving the object with the mouse.  For other objects such as furniture or poles, the default 
setting is “Ground”.  This means the object will move along the ground when moving the object 
with the mouse.  You can change this setting any time as needed. 

Locking the X, Y and Z Axes 

When precise positioning is needed, using the arrow keys in conjunction with locking the X, Y or 
Z axis can yield the best results.  When an object is selected, three colored axes run through the 
object.  These axes are color coded to the match the color of the X, Y, and Z letters in the 
ribbon.  Clicking on one of the X, Y or Z buttons will lock (i.e. freeze movement to) that axis and 
the axis line will turn yellow.  The object’s motion and rotation will be limited to that axis.  
Using the arrow keys, it is very easy to make precise adjustments.   Holding the shift key while 
using an arrow key makes adjustments in very small increments. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The “Move by” command under the Transform Object menu on the ribbon allows precise 
movement along the X, Y and Z axes using numeric measurements. 

 

Yellow indicates axis is locked, so movement 
is limited to up/down and around that axis 

Movement plane affects movement of object 
with mouse when X, Y and Z axes are not locked 

Use “Move by” 
command to 
move by numeric 
amount 
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Resizing Objects 

Using dimension sliders, boxes, and scale controls 
 
There are three different ways to resize objects. First, there are the width, height and depth 
sliders in the object properties tab.  Second, there are boxes to the right of each slider where 
exact dimensions can be entered.  Finally there are scaling controls under the Transform Object 
menu on the ribbon. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Rotating Objects 
Using special keystrokes and rotate controls 
 
In addition to the axis lock controls described previously, Awning Composer also provides two 
other methods to rotate objects.  After an object has been selected in the 3D view, press the 
“9” key on the keyboard to rotate it by 90 degrees. 
 
You can also use the Rotate controls under the Transform Object menu on the ribbon.  As an 
example, entering “90” in the box next to “Y Axis” and clicking on “Rotate +” will rotate the 
object to the right by 90 degrees, the same as pressing the “9” key as described above. 
 

 

 

The object size can be scaled 
along one axis or all axes 
using the Scale tab of the 
“Transform By” window. 

Use these sliders to change the object size.  Clicking on the bar next 
to the center slide button changes the size in one-foot increments. 
Right clicking on the slider allows changes to the min/max values. 

Dimensions can be entered into 
these boxes.  Feet / inches can 

be changed to inches or cm 
using the drop down menu. 
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Aligning Objects 

Using alignment tools 
 
There are two methods available for aligning objects that are both under the Transform Object 
menu on the ribbon.  The “Align to” command is used to align an object to a specified part of a 
target object.  An example would be lining Object B up with the left side of Object A.  To 
perform this command, select Object B, then select “Align To”, then select “Left” and click on 
Object A. 
 
The “Align” command is used to align the same parts in two different objects.  In the example 
below, the goal is to create a combo awning from a convex and round dormer awning.  To 
accomplish this, select the Round Dormer awning, then select “Align”, then select “Centers” 
and click on the Convex awning as shown here: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Here are the results of these two examples: 
 
 
 
 
 
 
 
 
Note:  The “Align Axes” command is an advanced command that is only used when it is 
necessary to shift the local axes of an object to match the orientation of another object.  This 
can be useful sometimes when working with imported 3D models. 
  

 

Results of Align to Left command: 

 

Results of Align Centers command: 
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Grouping and Combining Objects 

 
There are two methods available for joining multiple objects together and they each have their 
own set of advantages.  Using the “Group Object” button on the ribbon (or “Group” command) 
groups the selected object with another object or group of objects.  More objects can be added 
to a group by using the command over and over again.  Grouped objects can be moved and 
rotated together, affecting the group as a whole.  However, the grouped object cannot be 
scaled as a group so each object must be sized individually. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The “Combine Grouped Objects” command under the Group Object menu creates a single 
object made up of the parts from all of the members of the group.  This object can be moved 
just like a grouped object, but it can also be scaled using the width, height or depth slider bars, 
dimensions or scale commands.  This can be an advantage or disadvantage depending on the 
situation.  As an example, scaling the object shown above using the width slider will create an 
object that looks distorted: 

 
So in this case it might have been better to leave the object as a group and adjust the 
dimensions of each member of the group individually to prevent the Round Dormer from 
becoming distorted.  

 

After an object has been grouped, the object and 
its parts will be shown in a color other than black.  

Different groups appear as different colors. 

After objects have been combined, 
parts from both objects now 

belong to a single object. 
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Splitting Object Parts 

 
A part of an object can be separated into its own object using the “Split” command.  To use the 
Split command, first select the part to be split.  Make sure it’s highlighted in the Object Parts 
tree.  Then right click on it in the 3D view or in the Object Parts tree and choose “Split” from the 
context menu. 
 
This command can be useful when size or position adjustments need to be made to an 
individual part.  As an example, assume that one of the poles on a 3-point shade sail needs to 
be tilted.  The three poles and shade sail are part of a combined object.  Before the pole can be 
adjusted, it needs to be split from the main object as shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After the Split command was executed, the pole is a separate object that can be resized or 
repositioned independently of the rest of the shade sail object.  After adjustments have been 
made to the pole, right click on the pole and use the “Recombine” command to make it a 
member of the shade sail object again. 

Wireframe Display Mode 

It can sometimes be useful to work with objects in wireframe mode.  Right click anywhere in 
the 3D view with no objects selected to bring up the context menu, select “View” and then 
“Wireframe”. 

 

 

Right clicking on the 
pole brought up this 
context menu with 
the Split command. 

After using the Split 
command, the pole 
is now a separate 

object. 
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Applying Valances to Objects 

Includes expanded selection of valances, dimensions and auto sizing based on pattern repeat 
 
Awning Composer includes the ability to add customizable valances to awnings.  There are 
many different valance styles supported, and various parameters can be adjusted to customize 
the appearance of the valance beyond just the basic shape.  
 
Valances are built to scale using physical dimensions.  It’s also possible to automatically space 
the valance cutouts based on the fabric repeat.  Below is an overview of the new valance 
controls and their location in the program: 
  

 

Apply Valance button shows 
the list of valance styles 

Hold cursor over each valance style 
to see detailed description 

This column controls all valance and braid specifications.  
Changes can be made by typing in new values in the 
“Specified” column or by using the up/down arrow keys to 
change values by 1 inch.  Shift up/down = half inch 
increments. CTRL up/down = ¼ inch increments. 
ESC = clear value and reset back to initial value. 

Use this button 
to restore all 
initial values.  

Use this option to 
automatically 
calculate pattern 
width based on 
fabric repeat. 

Select Valance in object tree to view 
and change valance specifications 

Standard braid colors can be found 
under the “Apply Materials” button 
or click here to apply a custom color. 
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Applying Materials 

Includes selection by manufacturer, fabric name or pattern number search and tree view 
 
The “Apply Materials” window allows fabric, frame and braid colors or other textures to be 
applied to a selected object.  You can also search by name or pattern number.  For fabrics, a 
checkbox at the bottom left controls the display of the fabric repeats as shown below: 

Click on the desired material to apply that material to the selected object (or part of an object).  
Double-click on a material to apply it to the selected object and automatically close the 
window. 
 
For fabrics, there are “Info” buttons next to manufacturer and fabric line.  Clicking these 
buttons will open PDF files that can be printed out on your color printer, providing a 
professional looking attachment for proposals.  
 
In addition to the familiar drop-down boxes for selecting fabrics, a tree view that shows all 
manufacturers and fabric lines is also available.  Click on the “Show all styles” check box to see 
the tree view (as shown in the example below on the left side):   

The small arrows next to each manufacturer control the amount of detail that is shown.  In the 
example shown above, the arrow next to Glen Raven was clicked to reveal three fabric lines.  
Clicking the arrow next to an item will show or hide its contents. 
 
Note:  Not all controls are available when the tree view is displayed.  Uncheck the “Show all 
styles” checkbox if you need to print manufacturer or fabric info or to do a fabric search. 
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Applying Fabric Colors to Frame Parts 

After an object is added to the scene, usually the next step is to apply a fabric and/or frame 
color.  When using the Apply Material button, clicking on a fabric will apply it to only the fabric 
parts.  Clicking on a frame color will apply it to only the frame parts.   
 
But what if the customer wants the fabric color applied to both the fabric and the frame?  
Awning Composer supports this but it must be done on a part-by-part basis.  This means you 
must first select the individual frame part from the Object Parts list in the upper left corner and 
then apply the fabric to that part. 
 
To understand why the system works this way, we need to dig deeper into how each of these 
parts are classified.  Start by selecting each individual object part, go to the Material tab in the 
lower left, and look at the Material Type for that part.  For a Traditional awning, the fabric parts 
have a material type of “Fabric” and the frame parts have a material type of “Frame”. 
 
When a fabric is applied to the object, all of the parts classified with a material type of “Fabric” 
will have the fabric applied to them.  The same thing occurs when a frame color is applied; the 
frame color will be applied to all parts with a material type of “Frame”.  However, when an 
individual part is selected (instead of selecting the entire object at the top level), it overrides 
this classification system and allows any type of material (fabric, frame, etc.) to be applied to 
any part regardless of its material type. 
 
Below are three examples of the Material tab with various parts selected.  Note that when the 
object is selected at the top level, there is no Material Type shown, which indicates that the 
object has multiple material types. 
 

Object Selected Fabric Part Selected Frame Part Selected 
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Changing Fabric Repeat and Offset 

When a fabric is added to an object, Awning Composer uses the repeat width of that fabric to 
determine how many times the pattern will be displayed across the object.   This repeat width 
can be changed using the H. Repeat (Horizontal Repeat) slider located in the Texture tab.  Note 
that H. Repeat is linked to V. Repeat by default.  Right click on the lock icon on either slider to 
unlink the two controls. 
 
The location where the pattern starts can be changed using the H. Offset (Horizontal Offset) 
slider.  This is most often used to make the pattern look symmetrical on the awning.  If a 
valance has been applied to the awning, this slider can also be used to line up the fabric pattern 
with the valance cutouts. 
 
The controls in the Texture tab can be used to adjust the fabric for the entire awning or for just 
one part.  If the top level awning object is selected in the Object Parts list, the controls will 
affect all parts of the awning.  If an individual part is selected (e.g. Left fabric), the controls will 
affect only that part. 
 
Fabric before adjusting the Horizontal Offset: 

 
 
Fabric after adjusting the Horizontal Offset separately on the front and on the left sides: 

  



 

Awning Composer 5 Documentation Page 26 of 84 

Creating Custom Fabric Panels 

Panels can be used to mix and match different fabrics to create a custom design.  Panels are 
most often used for creating a custom design on the front face of an awning, but they can also 
be used on the sides of the awning or on the valance.  Before adding any panels, be sure to 
select the face of the awning by clicking on it in the 3D view or in the Object Parts window.  
After adding a panel, you can apply a material to it the same way you’d apply a material to an 
object.  You can also set the panel’s properties to specify its positioning and sizing. 
 
There are two types of panels: 

 Joined panels are joined together one after another along the object’s surface.  By 
default, the panel width is automatically calculated to evenly fill the available space.  For 
example, when three panels are added to the front of an awning, each panel will be 
automatically sized to take up one third of the awning width.  The width of a panel can 
also be specified in units (e.g. feet/inches/cm) or as a percentage of the available space. 

 Floating panels can be positioned anywhere along the object’s surface.  They must have 
a width specified in units or percentage. 

 
The following properties apply to an entire collection of panels: 

 Mirror – (Joined panels only) – This option creates a mirror image of the panels.  For 
example, assume we have specified three panels that are red, white and blue.  The 
Mirror option will produce 5 panels on the awning: red, white, blue, white, red. 

 Repeat – (Joined panels only, no Auto widths) – This option repeats panels along the 
entire object’s surface.   For example, assume we have specified three 1-foot wide 
panels that are red, white and blue.  On a 6-foot wide awning, the Repeat option will 
produce 6 panels on the awning: red, white, blue, red, white, blue. 

 Sync valance – This option keeps all of the panels the same on both the fabric and 
valance, which is typical.  By disabling this option, you can make the valance appear 
differently with a single material (no panels), or its own unique set of panels. 

 
 
 
 
 
 
 
 
 
 
 
 
 

In the example above, a green awning was used as a starting point.  Floating panels were used 
to define two 1-foot wide white panels set in 1 foot from each side of the awning. 
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Applying Graphics to Objects 

Images (such as logos) can be applied to the surface of any object or backdrop 
 
The Apply Graphic command allows logos or any image to be applied to the surface of an 
object. 
 
The graphic will follow the shape of the surface it is being applied to.  In the example below, a 
coffee cup logo has been applied to a ribbed bullnose awning and you can clearly see how the 
cup has taken the shape of the underlying fabric: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Transparent regions within a graphic (such as the space inside of the coffee cup handle in the 
above example), must be specified as “transparent” within the image file itself.  To find out 
more about how this can be done, please see the section titled “Making Parts of Graphics 
Transparent”. 
  

 

After the graphic has been 
applied to a 3D object, it will 
appear as a child object.   

The size of the graphic can be 
controlled using the sliders in 
the object tab or by entering 
actual dimensions. 

The graphic can be repositioned 
by left clicking on it and holding 
the left mouse button down 
while moving the graphic to a 
new position. 

Dashed outline 
around graphic will 
only appear when 
it is selected.   
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Adding Graphics to Backdrops 

Graphics can also be added to backdrops.  First select the backdrop by highlighting it in the 
Scene Objects tree.  Then use the “Apply Graphic” button on the ribbon to bring the graphic 
into the scene.  Adjust the size and position of the graphic using the sliders in the Graphic tab in 
the lower left hand corner. 

Layering of Graphics 

Awning Composer allows multiple graphics to be displayed over each other.  In the scene 
below, the graphic of a coffee cup was added to the front of the backdrop.  Then a graphic of a 
star was added to the front of the coffee cup. 
 
The order of these layers is controlled by the order in which they are listed in the Scene Objects 
tree.  In this example, the star (SimpleStar) is listed first so that is the top layer.  The coffee cup 
(Coffee) is listed next so that is shown behind the star. 
 
To change the order in which graphics are displayed, right click on the graphic you want to 
move and use the “Move Up in List” or “Move Down in List” commands. 

  

 

Right clicking on the graphic name in the Scene Objects tab allows 
you to move that graphic up or down in the list controlling the 
order in which it is displayed.  Graphics at the top of the list are 
displayed on top of the graphics listed below them.  In this 
example, “SimpleStar” is shown first so it displays after the graphic 
of the coffee cup, essentially showing the star on top of the cup. 
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Making Sections of Graphics Transparent 

Using image editing software such as Paint.NET 
 
Awning Composer supports transparency for a graphic using the transparent area defined 
within the image file.  If transparency is needed, the image file type must be PNG.  This is 
because other common image formats such as JPEG or BMP don’t store transparency 
information. 
 
If you don’t have the graphic available in PNG format with transparency defined, you’ll need to 
use separate image editing software to prepare the graphic before loading it into Awning 
Composer.  One example of such software is a free application called Paint.NET, which we've 
provided instructions for below.  To get Paint.NET and other software recommendations, visit 
the Awning Composer web site and go to the Recommended Software page in the Support 
section. 

 Example: Assume that your customer has sent you a copy of their 
logo in JPEG format as shown on the left. The black regions 
represent the transparent sections that should not be visible 
when the logo is brought into the Version 5 scene. You can define 
these black regions as transparent using the steps below. 
 

 
Open the logo in Paint.NET. Select the Magic Wand tool in the 
Tools window. Left click anywhere on the black area to select it. 
Note that you can control the sensitivity of what is being selected 
using the Tolerance level in the toolbar at the top. Go to the Edit 
menu and choose Cut. The black area is deleted and replaced 
with the checkerboard pattern which indicates transparency. 

 Now use the Magic Wand and Cut command to remove the black 
from inside the letters "A", "O", "P" and "R". Go to the File menu 
and choose Save As.  Next to "Save as type", select PNG and then 
save the image.  The regions showing a checkerboard pattern will 
be transparent when using this logo with Awning Composer's 
Apply Graphic command. 

 
The picture below shows an awning after the modified logo in PNG format was added using the 
Apply Graphic command: 
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Applying Text to Objects 

Includes bold, underline and italic fonts plus text outlining (stroke control) 
 
Adding text is very similar to adding graphics.  First an object must be selected.  Then the 
program applies text to that object so that it follows the surface shape of the object.   
 
The “Apply Text” command can use any fonts that are installed on your computer.  To add an 
additional font, simply install the font in Windows and then restart Awning Composer.  The new 
font will be available in the font selection drop down box in the Text tab. 
 
Below is an overview of the text controls and their location in the program: 
 

 
Note that you can also add text or graphics to the backdrop or the ground.  Make sure the 
“Show all objects” checkbox at the bottom of the Objects Parts list is checked.  Click on 
“Backdrop” or “Ground” in the Object Parts list to select either of these objects.  Then apply 
your text or graphics just like any other object. 
  

 

The Text tab can be used to change 
the text, as well as its font and color. 

Stroke controls the color (black) of the outline around the edge of the characters.  If there is 
no outline, then the stroke window is clear.  Thickness (on right) controls the outline size. 
Note: A black dashed alignment box appears around text or graphics whenever it is selected. 

“Fill” (on left) controls the color (yellow) of 
the characters, which can be set from fabrics 
or RGB colors.  “Weight” controls the 
thickness of characters (bold, normal, etc.) 

The Apply Text button adds a text 
object to the selected object. 
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Undo / Redo 

Undo last action or multiple actions, or redo 
 
Awning Composer offers undo and redo commands similar to other applications to make it easy 
to quickly undo unwanted changes.  The buttons for these commands are located in the quick 
access toolbar at the top of the program window: 
 
 
 
 
 
 
 
 

Clicking the Undo icon steps back one action and clicking the Redo icon steps forward one 
action.  Hovering over each of these icons will display a tool tip for the action about to be done. 
 
A Multiple-undo command is also available.  By clicking on the down-arrow next to the Undo 
button, you can scroll down the list of previous actions and highlight the last action in a series 
of actions to be undone.  At the bottom of the list of actions, Awning Composer will display the 
message “Undo x Actions”, where “x” is the number of actions to be undone.  To complete the 
multiple-undo, left click on the highlighted action. 
 
 
  

 

 

Undo      Multiple-undo       Redo 
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Sky and Automatic Lighting 

Create realistic shadows based on building location, orientation, time of year and time of day 
 
Awning Composer can automatically set the light levels, direction of sunlight, and shadows in 
response to various input parameters.  This feature can be used with any type of backdrop. 
 
In addition, Awning Composer can show a computer-generated sky behind the backdrop (when 
the background is set to “Sky”).  This is most useful when the backdrop image has been edited 
to remove the original sky and the ground by making them transparent.  This can be done using 
image editing software such as Paint.NET.  To get Paint.NET and other software 
recommendations, visit the Awning Composer web site and go to the Recommended Software 
page in the Support section. 
 

Making Parts of Your Backdrop Transparent 

In the image editing software, use the selection tool to crop the picture at the bottom of the 
building to remove the ground.  Then use the selection and erase tools to cut away all of the sky 
above and around the sides of the building.  Areas that have been cut away become 
transparent and are designated by a checkerboard pattern.  The goal is to end up with just the 
building and no sky. 

 
 

 
 
Open the modified backdrop image using the “Open from file” command under the “Set 
Backdrop” icon.  During the backdrop loading process, specify the backdrop type as “Straight-
on”, set the scale of the backdrop using a known point of reference (such as a doorway), set the 
ground to “Visible” and set the level of the ground so it aligns to the bottom of the building.  
 
After adding awnings to the building, click on the “Sky” tab to access sky controls which 
simulate actual sky and shadow conditions for your rendering.  The following information is 
required to calculate accurate shadows: 

1) Date and time of day 
2) Building location (city/town or LAT/LON) 
3) Compass direction that photo was taken 

 
Original backdrop image Image after sky and ground have been cut away 
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Based on this information, Awning Composer will calculate the exact sun angle and cast an 
accurate shadow based on the dimensions of the awnings in the scene. 
 
There is also a “Time Lapse” feature that allows you to view the shadow as the sun rises, shines 
through the day and sets.  The speed of this time lapse can be controlled to create a very fast or 
very slow rate of sun travel. 

Sky Controls 

Here’s an overview of the main controls available in the Sky tab: 
 

 
Helpful Hint: If you want to see the angle that the sun is hitting the awning, turn on the “Rotate 
Light” feature on the Home tab before accessing the Sky tab.  As the sun crosses through the 
sky, the “spotlight” will be pointing at the awning in line with the sun angle so that you can 
visualize the position of the sun in the sky at any time of the day. 
  

 

Time of day slider Date control 

Time lapse controls 
(speed and start/stop) 

Compass direction you were 
facing when picture was taken 

Cloud controls 

Shadow calculated 
based on sky settings 
and awning dimensions 



 

Awning Composer 5 Documentation Page 34 of 84 

Image Quality Hints 

For screen display, printed or saved renderings 
 
When applying striped or jacquard fabrics to objects, sometimes distortion appears across the 
object.  This occurs much less frequently than in older versions of Awning Composer, but when 
it does occur, it can be reduced or eliminated by using the smoothing control.   This control is 
located under the “Texture” tab in the object properties box in the lower left corner of the 
program window. 

Smoothing 

Smoothing works by smoothing the image of the fabric to eliminate distortion.  If too much 
smoothing is used, the fabric may look blurry. 
 
The above fabric after smoothing: 
  

 

 

Texture tab becomes available 
when object is selected 

Smoothing slider that can be used to remove distortion in fabric 
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Printer Resolution vs. Screen Resolution 

In most cases, even low end color printers are capable of producing more detailed images than 
your computer screen can display.  Most printers are capable of a minimum of 300 dots-per-
inch (DPI) output versus a computer screen that displays images at about 100 DPI. 
 
Saving your scene as an image can also be done at a much higher resolution than your 
computer screen can display.  So even if you do not adjust smoothing at all, images with 
distortion in the fabric may print out (or be saved) just fine due to the higher resolution 
available for these functions.  As an example compare the following two pictures: 
 
Awning shown on computer screen with no smoothing: 
 

 
 

Same awning as above printed out, also with no smoothing: 
 

 
So before trying smoothing, be sure to check the printed or saved rendering, because 
smoothing may not be needed at all depending on the capabilities of your printer.  And 
remember that too much smoothing can induce blurriness into your rendering. 
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Object Brightness and Specular Lighting 

Lighting is the key to making a rendering appear realistic. After getting the sun angle correct 
using the Sky controls or manual direction adjustment, lighting level adjustments can be made 
using the Emissive (object brightness) and Specular lighting slide controls, which are located on 
the Materials tab in the properties section in the lower left hand side of the screen. 
 
The Emissive slider is used for adjusting the brightness of an object.  For example, assume a 
rendering includes a backlit awning depicted in early evening.  The scene would be shown in 
low light conditions so the awning would be darkened.  Select the awning and then slide the 
Emissive slider to the right to increase the light coming from the object, making it look like a 
backlit awning.  (Note: Emissive lighting for both awning and text objects was increased here.) 
 
 
 
 
 
 
 
 
 
 
Specular lighting is used to control the reflection off a shiny object.  When you look at the 
chrome accents on your car on a sunny day, you see a bright spot of sun being reflected.  The 
Specular slide control is used to increase or decrease the intensity of that type of reflection. 
 
However there are more factors other than intensity needed to create the Specular lighting 
effect.  The angle of the sunlight in the scene, the curvature of the object, and the direction the 
object is being viewed from are also important factors.    

Normal Lighting 

 

Increased Emissive Lighting 

 

Sunlight overhead –  
no specular highlights on poles 

 

Sunlight low in the sky – 
increased specular highlights  

 

Settings used to achieve 
specular effect on poles 
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Color Controls 

Advanced controls for special lighting situations 
 
In certain cases, none of the previous lighting adjustments will give you the results you are 
looking for in your scene.  For these special cases, there is a set of color controls on the 
Materials tab.  Warning!  Using these color controls can drastically change the color of the 
awning material and therefore they should be used sparingly! 
 
In the example scene below, the fabricator was trying to show a customer what his building 
would look like with a new Sunbrella Pacific Blue awning.  But the picture was taken in very 
bright conditions and the camera overexposed the picture causing it to look even brighter.  
(Note that the color of the bricks in the picture looks more pink than red.) 
 
Adjusting the sun angle or changing the object brightness will not change the fabric color 
enough to match the backdrop picture in this scene.  By using the “Brightness” color control, 
we were able to lighten the fabric color to match the picture and provide a more realistic 
rendering. 
 
 
 
 

  

Existing Pacific Blue 
awning looks lighter due 
to over-exposed picture 

New Pacific Blue awning 
with brightness adjusted 

New Pacific Blue awning 
with no adjustment 

Color Controls 
Hue – Adjusts wavelength of color from red through 
yellow, green and blue. 
Saturation – Adjusts strength of color from muted/gray 
through intense. 
Brightness – Adjusts lightness of color from dark to light. 
(Used to adjust color in above example) 
Contrast – Enhances or reduces the contrast between 
different colors located close to each other. 
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Obscuring Objects 

A way to put “windows” into canvas enclosures 
 
There are times when you need to cut a hole into a canvas partition to make it look realistic.  A 
common example would be adding a window to a canvas enclosure.  To support this capability, 
there is a property called “Obscure” in the Materials tab in the properties section in the lower 
left hand side of the screen.  This property allows one object to obscure another one – that is, 
prevent the second object from being visible where the two overlap.  This produces the 
appearance of a window when a transparent object is used to obscure a solid object. 
 
The process involves three steps: 

1) Choose an object to be aligned with surface of the canvas – this is the obscuring object. 
2) Set the obscuring object to obscure the canvas surface by setting its Obscure property. 
3) Set the opacity of the obscuring object to zero, effectively creating a hole in the canvas 

that is the same as the size of the obscuring object. 
 
In the following example, we used a Vertical Plane from the Misc. Objects tab to create a wind-
break in front of this building that is attached to the front edge of the awning.  We then used 
another Vertical Plane as the obscuring object to create a “window” and we used the “Align to 
Front” command to align the “window” with the front of the wind-break.  Finally we used the 
Obscure command to link the window to the wind-break and set the opacity of the window to 
zero.  Since all of these parts were called “Vertical Plane”, we renamed them to prevent 
confusion (see Object Parts window). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Shortcut:  Once the left window was created, it was duplicated (right click then choose 
duplicate command from menu), the X-axis was locked and the duplicated window was slid 
across into the right window position. 

 

Opacity set to zero creates 
“window” in “wind-break” 

Obscure command links 
“window” to “wind-break” 
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Rendering and Saving Images 

Producing images that can be emailed to customers 
 
You’ve finished setting up your scene and now you want to share the result electronically with 
someone who doesn’t have Awning Composer.  Maybe it’s by email, maybe copying it to a flash 
drive, or posting it on a web site.  Or maybe you want to open it in another program.  In all of 
these cases, the next step is to save the scene as an image file. 
 
Click the “Render Image” button on the File tab and the following interface will be shown: 

 
First choose the desired size of the output image.  This will vary depending on whether you 
want to display the image on a small screen, a large screen, or eventually have it printed.  The 
size of the image affects the size of the file and the amount of time it takes to render the image. 
 
Next choose the area of the image you want to save.  On the right side, you’ll see a preview of 
the scene where you can choose the area to keep.  This is called cropping the image.  When you 
place the mouse cursor over the scene image, you’ll see five boxes show up.  You can drag 
these boxes to create an outline around the area you want to save. 
 
Note: In the Advanced options, there’s a setting for anti-aliasing.  Using a higher setting for 
anti-aliasing will improve the smoothness of edges of 3D objects in the scene, but it will take 
longer to render the image.  This setting has no effect on the final output size of the file. 
  

 

Choose size 
of output 
image here. 

Click here to adjust 
specific size and quality 
options. 

Use boxes to crop image. Only the 
highlighted area will be saved. 
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Printing and Page Layout 

Flexible interface allows you to quickly create professional looking renderings for your proposals 
 
Awning Composer includes printing support and a flexible page layout interface located on the 
Print page of the File tab.  Like most programs, you can choose the printer, paper size, 
orientation and other common printer settings.  However, the page layout interface goes much 
further by allowing you to create a completely customized page that includes one or more 3D 
renderings, free-format text, and imported images such as logos and graphics.  Once your page 
design is complete, you can save it as a template and use it for future jobs.  Eventually you can 
build up a library of templates, each one targeted to a specific market segment. 

Page Layout Toolbar 

The key to unlocking the power of the page layout feature is getting to know the Page Layout 
Toolbar located next to the page layout area.  This toolbar contains the following functions: 
 

 

 

  

New Layout (Ctrl+N) – Clears the current layout and all formatting so you can 
start designing a new layout from scratch. 

Open Layout (Ctrl+O) – Opens an existing layout.  The rendering from the 
current scene will automatically be substituted into the layout that you open. 

Save Layout (Ctrl+S) – Saves the current layout.  Try to use descriptive filenames 
like “Engineering style with side info panel” or “Rendering with watermark”, etc. 

Set Current Layout as Default (Ctrl+D) – Makes the current layout the default.  
The default layout is loaded when you start the program or create a new scene. 

Cut (Ctrl+X) – Removes the currently selected object (text, image, etc.) from the 
page and places it on the clipboard.  Note that you cannot delete the rendering 
of the current scene. 

Copy (Ctrl+C) – Copies the currently selected object to the clipboard.  This can be 
a text box, image or the rendering.  By hiding the awnings in your scene and 
“copying” the rendering, you can easily insert a “before” image into your layout. 

Paste (Ctrl+V) – Pastes content from the clipboard onto the page.  If an object is 
selected when you paste, its content can be overwritten. 

Undo (Ctrl+Z) – Undoes the last page layout operation performed. 

Redo (Ctrl+Y) – Redoes the last page layout operation that was undone. 

Add object to page – Displays a context menu that contains these options: 

Add Text Box (Ctrl+T) – Creates a new text box on the page.  Right click in text 
box to add fabrics and font colors from context menu.  After entering text, you 
can use the text controls at the bottom of the window to change options such as 
the font size, font, text alignment, text color or background color. 
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Add object to page – continued: 

Add Rich Text Box (Ctrl+H) – Creates a new rich text box on the page.  This works 
the same as a regular text box except that it supports mixed fonts, different font 
sizes and multiple colors.  The regular text box can only have one type of font, 
one font size, one text color and one background color for the entire text box. 

Add Image (Ctrl+M) – Adds an image from an image file to the page.  This can be 
handy for adding your logo, an engineering stamp, pictures of brackets, etc. 

Add Table – Creates a table object on the page with controls for specifying 
multiple rows, multiple columns and controlling the look of the table.  The table 
has a special ability to dynamically adjust rows based on the number of awning 
objects that are in the scene.  (See below for more details on how to adjust 
tables.) 

Add Parts List – Adds a frame parts list from the Frame tab in the Estimation 
panel.  Uses the same table interface as the Add Table command. 

Add 3D View – Adds a window which shows the current awnings in the scene.  
The size of the view that is shown in the 3D view window can be adjusted using 
the cropping controls under the Render Image function on the File menu.  The 
size of the window can be controlled using the adjustment blocks in each corner 
of the window. 
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Adjusting Page Layout Tables 

The key to creating a professional looking quote is to use the table feature contained in the 
page layout system.  Tables provide an easy way to line up columns and rows of text or pricing 
information.  Clicking on the Table Properties icon after adding a table will bring up the 
following window: 
 

 

 

 
The widths of the columns can be adjusted in two ways.  In the Table Properties window, you 
can enter a number for the width.  A width of 0 will automatically size the column to fit its 
contents.  You can also turn on the "Column headers" option and adjust the column widths by 
dragging the vertical dividing lines between column headers. 
 
Note 1: Only the vertical dividing lines between the column headers can be used to change the 
column widths - not the lines present on other rows of the table. 
Note 2: You can't click inside the column headers to enter text.  Column header text must be 
specified in the Table Properties window shown above. 
Note 3: All cells within a table must have the same font color, font size and background color.  
To make column headers look different than the rows below them, use a separate table. 
Note 4: To move a table, drag it by its gray background area below the table cells.  Be sure the 
Background option in the Table Properties window is enabled.  Alternatively, you can move a 
table by dragging the resizing boxes at the corners of the table. 
 
 

Positioning Tools and Text Box Toolbars 

At the bottom of the print page are two rows of toolbars. The upper row allows you to position 
and size the selected object (rendering, image, text box, etc.) using unit specifications.  These 
specifications will also change if you resize or reposition the object using the mouse.  This row 
also includes a lock command that allows you to lock an object’s position and size on the page.  
Locking prevents unintentional movement of an object after you have completed work on it. 
 

Specify alignment 
option for each 

column here 

Specify number 
of columns and 

rows here 

Control the look 
of the table with 
these checkboxes 

Specify names for 
each column here 

(optional) 
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The lower row provides a complete set of text controls.  Please note these controls work on a 
text box basis and not a word or letter basis.  As an example, assume that you have one word 
highlighted in the text box and you change the text color, then all of the words in the text box 
will be changed to that color.   
 

 
Also note the handy magnification tools in the lower right corner.  

 

 

Page Layout Context Menus 

Right clicking in the page layout or over an object on the page will bring up a context menu.  
These menus allow you to execute some of the functions on the toolbars, but they also have 
several commands that are not available in the toolbars. Toolbar commands that are available 
on the context menus include Cut, Copy, Paste, and Lock. 
 
Commands that are only available on the context menus are: 
   Delete – Deletes the selected object from the page. 
   Align – Centers the object or aligns it to the top, bottom, right or left side of the page. 
   Bring to Front – Position an object on top of other objects on the page. 
   Send to Back – Position an object under other objects on the page. 
   Opacity – Changes the visibility of an object so it fades into the background (watermark). 
 

 

Input fields for specifying the position and size of an object.  
These are automatically changed when the object is moved 
or resized using the mouse. 
 

Lock icon – used to 
lock the position and 
size of an object. 

Drop down 
box for 
font face. 
 

Drop down 
box for 
font size. 

Buttons for 
bold, italics 
and underline. 

Buttons for 
aligning text 
to left, center, 
right or justify. 

Changes text 
background 
color. Right 
click for 
transparency. 

Changes 
text 
color. 
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Including Multiple Renderings in the Page Layout 

 
By default, the page layout contains a single rendering showing the current contents of the 
scene as displayed in the 3D view when the Home tab is selected.  However, it’s possible to 
include multiple renderings on the page to show different views of an awning, different awning 
styles, the same awning with different fabrics, a before and after comparison, etc. 
 
Important: Whenever you make changes to the scene in the 3D view, the rendering on the 
page will change as well.  This object on the page is called the active rendering because it’s 
actively updated to reflect the latest contents of the scene.  When you have the active 
rendering selected, the resizing handles at its corners will appear with a green tint. 
 
To add additional renderings to the page, select the active rendering, choose Copy, and then 
choose Paste.  Reposition the copy to a different location on the page.  Now you will see two 
images showing the same scene.  Go back to the Home tab and make a change to the scene.  
Then go back to the File tab to return to the page.  You will see that the active rendering has 
changed, and you now have two different renderings on the page. 
 
You can repeat the copy and paste process as many times as you like to include any number of 
renderings on the page. 
 
Note that when you select the active rendering and choose Copy, the 3D scene is rendered as 
an image at that point in time.  The size and quality of the rendered image depend on the size 
of the active rendering on the page and the quality settings (such as resolution and anti-
aliasing) currently selected.  For the best results, make sure the active rendering is sized to the 
final desired size for the copy, and the quality settings are set as needed before choosing Copy.  
For example, if you set a small size and low quality for your active rendering and then resize a 
copy of that rendering to be much larger, the image could appear blurry or pixelated. 
 
All images on the page are stored in scene and layout files.  This ensures that the layout will 
appear intact when you save the scene or layout and open it later.  If you want to re-use the 
same layout with multiple renderings for many projects, you can prepare a layout with 
placeholder images pre-arranged in their desired locations, then copy and paste the active 
rendering over each placeholder image.   
 
To do this, use the Add Image command to create a layout containing some placeholder 
images.  (Use any image you like as the placeholder.)  Then save this layout with your company 
contact info.   
 
You can then open this saved layout and replace the placeholder images with images from the 
current job.  To do this select the active rendering, choose Copy, then select a placeholder 
image, and choose Paste.  The placeholder image will be replaced by the copy from your 
current job.   
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Printing and Other Output Options 

Output can be printed or saved as a PDF document (by selecting a PDF printer) 
 
Once your page layout is complete, you can print it on any printer installed on your system by 
selecting a printer in the printer selection drop down box and choosing Print. 
 
Before printing, you may want to save the page layout that you just finished for future 
reference using the “Save Layout” command described in the previous “Page Layout” section. 
 
You can also save your output as an image or print the page in PDF format so it can be emailed 
as an attachment to your customer.  Use the “Save As” command to save your output as an 
image.  To create output in PDF format, you will need to install a PDF printer if you don’t 
already have one.  Visit the Awning Composer website and go the Recommended Software 
page in the Support section. 
 
Once installed on your system, the PDF printer driver will appear in the printer selection drop- 
down box and function like other printers – except its output will be a PDF file. 

 
Note: Awning Composer is capable of printing at very high resolutions, large sizes, and at high 
quality.  However, depending on the size of the print job and the speed of your computer, the 
printing process may take a long time – especially when printing over a network.  If printing is 
taking too long, first try lowering or disabling anti-aliasing.  If it still takes too long, try lowering 
the resolution to 300 DPI or lower.  Finally, you can try making the images smaller on the page. 
  

 

Select printer 

Control 
output size 

Monitor 
output size 

Completed page layout 
ready to be printed 

Name of saved layout template Output image 
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Camera Distance and Field of View 

How Distance and Field of View (FOV) settings can be used to match a physical camera 
 
When you take a picture of a building with a camera, the camera is located a certain distance 
from the building and its lens has a specific focal length which determines magnification and 
field of view.  When you bring that image into Awning Composer, the program does not know 
these values.  You may need to adjust them in order to get the perspective of 3D objects in the 
scene to match up with the building perspective in the backdrop image.  This is especially true 
for pictures taken where the building is shown at an extreme angle, such as photographs taken 
down a constricted alley or a narrow roadway.   
 
You can change these settings in Awning Composer in the Camera tab which is located under 
the left side of the ribbon: 
 

 
 

Distance Controls the distance from the camera to the objects that you add to 
the scene.  As the distance is increased, objects in the scene will look 
like they are smaller since you are further away from them. 

Field of View (FOV) Controls the angle of the viewing area through which 3D objects are 
seen.  As the field of view is increased, objects will appear to be more 
tapered, especially when they are viewed at an angle.  A high FOV 
setting is like using a fisheye lens. 

Link field of view to 
distance 

This option is normally on (checked) and will help to keep objects in the 
scene in their current locations while the camera distance or FOV is 
being adjusted.  This switch can be turned off (unchecked), which allows 
the distance and FOV settings to be adjusted individually. 

Lock camera position 
and orientation 

This option is normally off (unchecked).  Turning this option on 
(checked) disables all of the basic camera controls (Zoom, Pan, Rotate) 
plus the distance control.  The FOV control remains enabled but the 
camera distance is fixed, so changing the FOV will act like changing the 
zoom level of the camera. 

Reset Camera Resets the distance and FOV settings to their default values.  
Note: The check boxes are not changed by the Reset Camera button and 
must manually be set back to their original settings. 
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Example of Customized Camera Settings 

The illustration below shows a backdrop image of a building with an outdoor deck.  This photo 
was taken at a sharp angle.  The customer wanted to install some exterior screens for weather 
protection.   

 

When the Exterior Screen object was 
added to the scene, its perspective did 
not match the backdrop image using 
the default settings in the Camera tab. 
 
(Observe how the angle at the bottom 
of the screen does not match the angle 
of the deck in the picture.) 
 

By doing some experimentation with 
the FOV setting, we were able to 
match up the angle at the bottom of 
the screen with the deck by increasing 
the FOV from 38 to 83.  As a result of 
this change, the Distance was 
automatically reduced to 15.57 feet. 
 
The length, height and location of the 
screen object were then adjusted to 
compensate for the change in distance 
which resulted in a perfect match 
between the perspective of the 
exterior screen and backdrop image.  
(Note alignment of deck and screen.) 
 

Default camera settings: 

 

 
Modified camera settings: 

 

With a little practice, FOV adjustments can be 
used to match 3D object perspectives on almost 
any angled backdrop image. 
However, we still recommend taking backdrop 
pictures straight-on whenever possible since those 
pictures can be scaled and positioning 3D objects 
on straight-on backdrops is a simpler process. 
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Dynamic Objects 

3D objects with fabric and frame components built to your specifications 
 
Awning Composer has two types of objects: pre-modeled and dynamic.  Pre-modeled objects 
can only have their structure changed by scaling (stretching) their width, height and depth, as 
well as hiding individual parts.  Aside from these simple controls, the structure of a pre-
modeled object is pre-determined cannot be changed. 
 
Dynamic objects are generated on-the-fly based on the parameters you provide.  These 
parameters include the basic dimensions such as width, height, and depth as well as rafter 
spacing, internal support spacing, sign band height, and various options. 

Adding a Dynamic Object to the Scene 

Use the “Add Object” button in the ribbon to add a dynamic object to the scene.  Dynamic 
objects are currently located in three tabs called Stationary, Corners, and Retractable: 
 

 
Dynamic objects appear in the list with translucent fabric in order to illustrate the underlying 
frame structure.  However, when the object is added to the scene, the fabric will be opaque. 

Customizing a Dynamic Object 

After a dynamic object has been added to the scene, an additional set of parameters will be 
shown under the width, height and depth dimensions.  The quantity and type of parameters 
will vary with each object.  The parameters below are for a Hipped Marquee awning: 
 

 

The Parameters section is only available for 
dynamic objects.  It contains additional 
measurements and options.  Parameters are 
organized within multiple tabs. 

Basic dimensions are available for all objects. 

Some parameters contain check boxes next to 
them.  Unchecking turns a parameter off. 

Other parameters are hidden until they are 
needed.   These Sign Band (SB) spacing 
parameters did not appear until the SB 
height parameter was turned on. 
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Dynamic Object Viewing Tips 

Dynamic objects include both fabric and frame parts.  There are two options that can make it 
easier to view the frame: an option to hide the fabric, and an option to display the frame parts 
in different colors. 

 

Master Bars 

The ability to view various frame parts in different colors is very useful especially when setting 
up master bars.  At certain joints in the frame (where two or three frame components come 
together), Awning Composer has the capability to set one of these bars to be the master and 
the other bars to be subordinates. 
 
The master bar goes all the way to the corner of the awning and the subordinate bars are 
attached to the master.  This is easier to see when the frame is shown with multiple colors.   
 
The master bar option also has a 45-degree miter option available.   Awning Composer will 
automatically provide options for each possible pair of components that can be mitered 
together at 45 degree angles. 

To hide the fabric, uncheck this box.  Any 
fabrics that were applied are preserved 
and will be shown again when the box is 
checked. 

Use this option to turn on multi-colored 
parts.  Any frame colors that were applied 
are preserved and will be shown again 
when the option is turned off. 
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Corners and Connected Objects 

One of the more powerful features of dynamic objects is the ability to join objects together to 
create a group of connected objects.  This happens automatically when you have an object 
selected in the scene and add a new object that is compatible with it.  For example, if you have 
a Traditional awning selected and you add a Traditional Square Corner, Awning Composer will 
recognize that these two objects are compatible and automatically connect them together. 

 
This awning was created using three Traditional Square Corner objects on the outside corners, 
one Traditional Inside Corner, and three Traditional awnings.  In the above example, one of the 
Traditional awnings was added to the scene first.  Then a Traditional Square Corner was added 
to the scene and the following prompt was shown at the top of the scene window: 
 

 
 
This prompt allows you to choose where the new object should be connected or if it should be 
brought in as a new stand-alone object (using the “Don’t connect” option).  Awning Composer 
will not display this prompt if it can automatically infer the most logical place to connect the 
new object.  In addition to the automatic grouping and connecting of objects that occurs when 
adding a new object to a selected object, you can also use the Group and Ungroup commands 
to manually connect and disconnect objects at any time. 
 
When dynamic objects are connected together in the same group, certain adjustments made to 
one object in the group will affect other objects in the group (when appropriate).  Examples of 
parameters that can be automatically adjusted within a group are height, depth, sign band 
height and lacing band height.   When you apply fabrics, frame colors, and valances to a group 
of objects, they will be applied to the entire group.  You can change this behavior and other 
group related options by clicking on the lower part of the Group icon in the ribbon to open the 
Group menu.  
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Dimensioning Objects 

Add dimensions with automatic positioning and ability to change location 
 
Basic dimensions can be added to any object by clicking on the top half of the Add Dimensions 
button on the ribbon.  Clicking on the bottom half of this button provides a list of options: 
 

 Add basic dimensions – adds the most commonly used dimensions describing the outer 

size of the object like height, width, depth and sign band height. 

 Add all dimensions – adds all of the dimensions that are available for this object. 

 Add select dimensions – brings up a list of dimensions that you have not yet added and 

allows you to choose which ones to add. 

 Add custom dimension – allows you to add a dimension based on the locations of two 

points on the object (or on separate objects). 

Once a dimension has been added, its location, size and other properties can be changed using 
the Dimensions tab in the lower left.  For each dimension, there can be one or more alternate 
locations where this dimension can be shown.  In the example below, the depth dimension 
(shown in red on the bottom left side of the awning) has 3 alternate locations available (bottom 
right, top right and top left). You can also change the offset distance (how far the arrow and 
dimension text is away from the endpoints of the dimension), the type, size, color, and units of 
the text, and indent level (used to stack multiple layers of dimensions above each other). 
 

 

Add Dimensions button 

Dimensions are shown in parts list 

Choose alternate locations for dimensions 
and also control the dimension offset (slider) 

Change dimension font type and size 

Selected dimension shown in red 

Indent controls 
stacking of 
dimensions 
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Relocating Dimensions 

Depending on the camera angle, some of the dimensions may not be visible or in a convenient 
location when they are first added to the object.  To help with this problem, most dimensions 
have one or more alternate locations.  To quickly run through all possible locations for a 
dimension, click on that dimension (it will show in red) and then click the “Next” button to the 
right of the Location setting in the Dimension tab on the left side of the screen.  You can also 
use the “]” key to move to the next location and “[” key to move to the previous location. 
 
There are three main ways to move a dimension outward from the object: changing the offset, 
changing the indent or by moving the dimension. 
 
Offset 
Offset allows you to specify how far away from its endpoints a dimension’s line and text should 
be.  This gives you a simple way to fine tune how close a dimension should be to an object.  To 
adjust the offset for all dimensions, select the “Dimensions” part in the Object Parts list and 
then adjust the offset.  This can also be done for individual dimensions by selecting the 
dimension name in the Object Parts list or by clicking on a dimension in the 3D view. 
 
Indent 
Each dimension has an indent setting.  An indent of zero means the dimension is located away 
from its endpoints by a distance that is equal to its offset.   An indent of 1 means the dimension 
is located a distance equal to its offset plus enough space for another dimension to fit below it.  
The indent setting provides a simple way to stack multiple dimensions on top of each other. 
 
Moving the dimension 
If the offset and indent still do not offer an appropriate place for the dimension, you can click 
on the dimension, lock the X, Y or Z axis and move the dimension to a new location.  Note that 
moving the dimension will move its endpoints as well as the dimension arrow and text.   Ideally 
it is better to relocate a dimension using the offset or indent settings since this keeps the 
dimension’s endpoints in their original locations. 

Orthographic View vs. Perspective View 

Most of the time when you are adding or changing objects in a scene, you are working in a 
perspective view.  As you look at an object, the end that is farthest away from you appears 
smaller than the end that is closest to you.  This works well when you are looking at the object 
from an angle (such as from one of the corners), but if you try to look at an object from the 
side, the front or the top, then certain parts are shown that normally would not appear on a 
CAD drawing. 
 
The solution to this problem is to choose Orthographic view on the Camera tab, which uses a 
straight projection of a three-dimensional object onto two dimensions.  Awning Composer 
makes this even easier by providing several preset views such as top, side, front, etc.  Clicking 
on these view buttons will automatically select Orthographic view mode and position the 
camera at the optimum angle so the dimensions are shown like they would be in a CAD-style 
drawing.  To switch to an isometric view, select the “top left” or “top right” preset. 
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Dimensioning Multiple Objects 

Alternate locations plus indent setting provides flexibility for relocating dimensions 
 
When creating a project that has multiple awnings (such as a corner awning), it can be difficult 
to show some of the dimensions because they may be hidden behind some of the awning 
components. 
 
By using alternate locations and the indent setting, it is possible to reposition dimensions so 
they are shown without being obstructed.   In the example below, the height and depth 
dimensions were repositioned using alternate locations (shortcut: “[“ and “]” keys).  The sign-
band/rafter spacing was repositioned using the indent setting to bring those dimensions closer 
to the frame.  Other dimensions that were redundant were simply turned off using the visibility 
control in the Object Parts list. 
 

The view below was created using the “Left” 
preset in the Camera tab which selects an 
orthographic view of the frame and dimensions. 

Same view with perspective 
instead of orthographic: 
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Before dimensions were repositioned: 

 
 
After dimensions were repositioned and the visibility of some dimensions turned off: 

 
 

Custom Dimensions 

Custom dimensions between any two points can be added to the drawing by clicking on the 
lower part of the Add Dimensions button.  Awning Composer will prompt for the location of the 
first point and then the location of the second point.  Custom dimensions can be adjusted using 
offset and indent settings just like any of the standard dimensions. 
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Creating a CAD-Style Frame Drawing 

Using the Page Layout feature in combination with orthographic views, it is possible to produce 
a CAD-style frame drawing with dimensions and views from multiple angles. 
 
The first step is to think about the views that are needed for the project.  For most single 
awning projects, a front view, side view and an angled view from the top left or top right will be 
sufficient.  In the following example, we will demonstrate how to create a CAD-style drawing 
using these three views. 
 
Adjusting the Background and the Light 
For best results, the frame should be shown as a dark color on a light background.  Click on the 
Backdrop tab and click the “Solid color” button under Presets.  Optionally, set the background 
color to white, but note that this step is not strictly necessary when using page layout as white 
will automatically be used as the background color for renderings included in a page layout.  
Finally, click on the Light tab and lower the ambient light level to “0.1”.  The frame should now 
look like it is dark gray with a solid background. 
 
Creating the Front Orthographic View 
The following steps will create a front view image that can be included in a page layout. 

 Click on the Camera tab and choose “Front”.  The awning will be shown with a front 
orthographic view. 

 Click on the lower part of the Add Dimensions button and choose “Add all dimensions”.  
This will add dimensions for width, height, sign band height, rafter spacing, sign band 
spacing, etc. 

 Click on the File tab and choose “Render Image”.  Use the resizing handles in the four 
corners to outline the awning and the dimensions. 

 Select the Print page on the left and note that the cropped front view image is now 
stored at the top of the page.  Resize this image down so it is only taking up the top ¼ of 
the page. 

 Right click on the image and choose “Copy” from the menu.  Then point to a blank spot 
on the layout page, right click and choose “Paste”.   Move the copy of the front view 
image to the bottom of the page. 

 
Creating the Side Orthographic View 

 Return to the Home tab, click on the Camera tab, and choose “Left”.  The awning will be 
shown with a left side orthographic view. 

 Click on the File tab and choose “Render Image”.  Use the resizing handles in the four 
corners to outline the awning and the dimensions. 

 Select the Print page and note that the cropped left view image is now stored at the top 
of the page.  Resize this image down so it can fit next to the front view image. 

 Right click on the image and choose “Copy” from the menu.  Then point to a blank spot 
on the layout page, right click and choose “Paste”.   Move the copy of the side view 
image so it is next to the front view image at the bottom of the page. 
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Creating the Angled View 

 Return to the Home tab, click on the Camera tab, and choose “Top left”.  The awning 
will be shown from the top left with an isometric view.  To get a more 3D look, you can 
optionally change the view from “Orthographic” to “Perspective” at this point, as 
illustrated in the result below.   If necessary, rotate the awning (by dragging it while 
holding down the right mouse button) so the dimensions are lined up with the frame. 

 Click on the File tab and choose “Render Image”.  Use the resizing handles in the four 
corners to outline the awning and the dimensions. 

 Select the Print page and note that the cropped front view image is now stored at the 
top of the page.  Resize and reposition this image as needed. 

 As a final step, you can use the Add text tool on the Print page to add text boxes to 
describe which views are being shown (e.g. front view, left side view, etc.) 
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Controlling Awning Composer 

Make the most of the input devices available to you 

Beyond the Mouse 

Many of the tasks in Awning Composer are best performed with a 3-button mouse.  But what if 
you are using a tablet or have a laptop with a touchpad?  As we will explore in this section, you 
can use other input devices to reduce or eliminate the need to use a mouse.  And if you have a 
keyboard available, you can use it in combination with other devices to get things done faster. 

Drag Lock 

When using a laptop’s touchpad, it can be difficult to perform a drag operation equivalent to 
moving a mouse while holding down its button.  By pressing the space bar, you can enter 
Awning Composer’s Drag Lock mode which is basically the same thing as holding down the left 
mouse button.  (Note: the status bar will display [Drag lock enabled] when this mode is on.) 
 
During this mode, you can simply drag your finger across the touchpad to change the position 
of objects, change the camera viewing angle, and perform a variety of other tasks as if you were 
holding down the left mouse button during the operation.  When you are finished, press the 
space bar again to exit from Drag Lock mode. 

Keyboard Shortcuts 

Many of the commands in Awning Composer can be performed with keyboard shortcuts, 
cutting down on the amount of point and click operations needed to use the program.  Below is 
a list of keys and the equivalent action(s) needed to take the same action with a mouse. 
 

General commands  
Equivalent mouse action(s) Key Command 

ESC Select none + 
enter Select 
Object mode 

Click in scene but not on any object to clear the selection, and 
click on Select Object in ribbon (if another mode is selected) 
 

Ctrl+N New scene Click on File tab, then New scene 
Ctrl+O Open scene Click on File tab, then Open scene 
Ctrl+S Save scene Click on File tab, then Save scene 
Ctrl+Z Undo Click on Undo button above ribbon 
Ctrl+Y Redo Click on Redo button above ribbon 
Ctrl+D Duplicate Right click on object, the choose Duplicate from menu 
Ctrl+G Group Click on Group object button in the ribbon then choose Group 

from menu  
Ctrl+U Ungroup Click on Group object button in the ribbon then choose Ungroup 

from menu  
Ctrl+F1 Toggle ribbon 

visibility 
Click on up arrow symbol on the right side of the screen near 
blue question mark 

. Next part Click on the next object part in the object parts list 
, Previous part Click on the previous object part in the object parts list 

Up Arrow Object up Click on the object, hold left mouse button, move object up 
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General commands  
Equivalent mouse action(s) Key Command 

Down Arrow Object down Click on the object, hold left mouse button, move object down 
Left Arrow Object left Click on the object, hold left mouse button and move object left 

Right Arrow Object right Click on the object, hold left mouse button and move object 
right 

Ctrl+Page 
Up 

Object further 
away 

Click on the object, hold both mouse buttons down and push 
mouse away from you 

Ctrl+Page 
Down 

Object closer Click on the object, hold both mouse buttons down and pull 
mouse towards you 

B Show 
backdrop 
browser 

Click on Set Backdrop button in the ribbon (press again to hide 
backdrop browser) 

O Show object 
browser 

Click on Add Object button in the ribbon (press again to hide 
object browser) 

M Show 
material 
browser 

Click on Apply Material button in the ribbon (press again to hide 
material browser) 

V Show valance 
browser 

Click on Apply Valance button in the ribbon (press again to hide 
valance browser) 

G Show graphics 
browser 

Click on Apply Graphic button in the ribbon (press again to hide 
graphics browser) 

T Apply Text Click on Apply Text button in the ribbon (applies text to the 
currently selected surface). 

X Lock X Axis Click on X button in ribbon (press again to unlock X axis) 
Y Lock Y Axis Click on Y button in ribbon (press again to unlock Y axis) 
Z Lock Z Axis Click on Z button in ribbon (press again to unlock Z axis) 
H Toggle part 

visibility 
Click on the visibility icon next to hide a currently selected part 
(press again to toggle visibility back on) 

Backspace /  
Delete 

Delete part Right click on object part and choose Delete from menu 

/ Center on 
object 

Click on Rotate Camera button in the ribbon, then hold down the 
Ctrl key and click on the object to center on 

C Close-up view Zoom in/out by scrolling the mouse wheel up/down 
Numeric 
Keypad 5 

Toggle view 
type 

Click on Camera tab and select Perspective or Orthographic view 

Home / 
Keypad 7 

Top left view Click on Camera tab and select Top left from presets 

End / 
Keypad 1 

Left view Click on Camera tab and select Left from presets 

Page Down 
/ Keypad 3 

Front view Click on Camera tab and select Front from presets 

Page Up / 
Keypad 9 

Top view Click on Camera tab and select Top from presets 

] Next dim. 
location 

Click on dimension in scene, and then click the Next button to 
the right of the location setting in the Dimensions tab. 
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General commands  
Equivalent mouse action(s) Key Command 

[ Previous dim. 
location 

Click on dimension in scene, and then use the drop down box or 
radio buttons to the right of the location setting in the 
Dimensions tab to select the previous dimension location. 

Modes and Touch Commands 

To simplify some tasks, Awning Composer offers several modes focused on specific tasks.  The 
status bar at the bottom of the screen shows which mode the program is currently in.  This area 
also lists the most common commands that can be used during the selected mode. 
 
The table below lists the keyboard shortcuts to get into each of these modes, as well as the 
most common keyboard and touch commands that can be used when the program is in that 
mode. 
 

Select Mode of 
Operation 

 
Equivalent 

mouse action 

 
Follow-up Keyboard 

Actions 

 
Follow-up Touch 

Actions Key Command 
S (or Esc) Select 

object 
mode 

Click on the 
Select Object 
icon in ribbon. 

Use . and , to select the 
previous/next object.  
Use arrow keys to move 
object left, right, up or 
down.  Use Ctrl-Page 
Up/Down to move 
object further away or 
closer. 

Tap an object to select 
it.  Drag one finger to 
move an object. Open 
and close (pinch) two 
fingers to zoom in and 
out.  Drag two fingers to 
rotate the camera. 

R Rotate 
camera 
mode 

Click on the 
Rotate Camera 
icon in ribbon. 

Use arrow keys to 
rotate the camera 
around its center point. 

Drag one finger to 
rotate the camera. 

P Pan 
camera 
mode 

Click on the 
Pan Camera 
icon in ribbon. 

Use arrow keys to pan 
left, right, up or down. 

Drag one finger to pan 
the camera. 

D Zoom 
camera 
mode 

Click on the 
Zoom Camera 
icon in ribbon. 

Use up and down arrow 
keys to zoom in and out. 

Drag one finger up and 
down to zoom in and 
out. 

L Look 
around 
mode 

Click on the 
Look Around 
icon in ribbon. 

Look around the current 
camera position using 
the right and left arrow 
keys. 

Drag one finger to look 
around the current 
camera position. 

I Rotate 
light 
mode 

Click on the 
Rotate Light 
icon in ribbon. 

Use arrow keys to 
rotate the light. 

Drag one finger to 
rotate the light. 
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Default Values Overview 

Objects can come into scene the way they are built in your shop 
 
Awning Composer lets you set default values for all dynamic object parameters.  Normally, 
dynamic objects come into the scene with a default rafter spacing of 24 inches.  If your shop 
uses 30-inch rafter spacing, you can set this as a default value instead of having to change it 
from 24 to 30 every time.   
 
You can set your own preferred default value for each dynamic object parameter and you can 
specify that your default value be used for all dynamic objects or an individual object.  Once a 
default value has been set, the object will come into the scene with the updated default instead 
of the factory default whenever you add objects to the scene. 
 

How to set a Default Value 

When a dynamic object is added to the scene, groups of parameters are visible under the 
Width, Height, and Depth sliders in the lower left corner of the main window: 
 

 
 
Clicking on a group name will open that group and show a list of parameters that can be used to 
modify the structure of the awning.   
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After clicking on the Main group the following parameters will be shown: 
 

 
 
When the mouse is moved over the name of one of these parameters, it will turn blue and 
underlined indicating a link is available: 
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Click on the link (which is the name of the parameter) to open the Set Default Value window: 
 
 
 
 
 
 
 
 
 
 
 
In this example, a value of 30 inches has been entered as the default rafter spacing value for all 
dynamic objects. 
 
Instead, if the value of 30 inches was entered into the lower text box, then it would only be 
used when adding a Traditional awning to the scene and all other objects would still use the 
factory default of 24 inches. 
 
By setting defaults for some or all parameter values, it's possible to pre-configure dynamic 
objects so they come into the scene matching the way your company builds awnings. 
 

Saving and Sharing Default Values 

When default values are set, they're stored in a file that can be shared with other people and 
computers.  You can also have multiple sets of default values.  For example, you can define one 
set of default values for lace-on awnings and another set for staple-on awnings. 
 
To access options related to default values, click on File, Options, and then Default Values: 
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In this example, only one default value (Rafter spacing) has been set, and it's been set for all 
objects.  This default value has been stored in a file called larrysdefaults.xml located in a folder 
called C:\Clink\Temp.  This file can be copied to another computer over a network or 
transferred using a USB thumb drive.  Once it's been copied to another computer, it can be 
opened using the Open button in Options, Default Values and all new objects added on that 
computer will have a default rafter spacing of 30 inches. 
 

Advanced Sharing Techniques 

One way to share default values with remote locations is to simply email the file as an 
attachment.  A more advanced and powerful alternative is to use a cloud storage service such 
as Dropbox or OneDrive. 
 
For example, if multiple users have access to the same shared folder on Dropbox, then the 
default values file can be stored in that folder.  Every user who needs to share the same set of 
default values can open that file using the Open button in Options, Default Values.  When one 
person updates the file with new default values, everyone who has configured Awning 
Composer to use that file will automatically be using the new default values.  It's not even 
necessary to restart Awning Composer, as the default value file is checked for updates each 
time a new object is added to the scene. 
 
When using a defaults file that's automatically shared between multiple users, it might be 
possible to have conflicts between users.  If multiple people change the defaults at the same 
time, one person's changes could be lost.  To avoid this, it's recommended that people 
coordinate before changing default values or decide on only one person who will update 
default values.  Sharing tools can also help with this.  For example, Dropbox can be configured 
to make the file read-only for some users but able to be modified by others. 
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Accessories Overview 

Add awning rail, Z-brackets, fasteners and other hardware to your awning 
 
The accessories feature is a flexible tool that can add hardware items to a dynamic object.  
Currently all of the accessory items that are added will appear in the Bill of Materials.  
Eventually these items will also be included in the Estimation calculations. 
 
Certain accessory items (such as Z-brackets and fasteners) will also be displayed in the 3D view 
along with the awning.  You can adjust their placement and other settings via properties that 
will become available in the Accessories group of dynamic object properties after you add these 
accessories to an awning.  The accessory system also allows a fabricator to add their own 
custom accessories in addition to the standard list of accessories provided with Awning 
Composer. 

Adding a Standard Accessory 

After adding a dynamic object to the scene, click on the Accessory group name in the lower left 
and you will see a Manage Accessories button.  Click this button to open the Add Accessory 
window:  
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The Add Accessory window lists standard accessories included with Awning Composer that can 
be added to any dynamic object.  If an accessory has something listed in the Visualization 
column, the accessory can be visualized, meaning that it will appear in the 3D view when added 
to a compatible object.  Accessories that can't be visualized will only appear in the Bill of 
Materials. 
 
The Accessory Details section can be expanded to view and edit details for a particular 
accessory, or enter your own custom details to add a custom accessory not included with 
Awning Composer. 

Adding a Standard Accessory with Visualization 

For this example, we clicked on the first item in the Add Accessory window then clicked OK to 
add a medium Z-bracket to our Traditional awning frame.  In the 3D scene window two Z-
brackets are shown; one at each end of the top bar: 
 
 
 
 
 
 
 
 
 
 
 

In the Accessories group, a set of parameters for the Z-brackets have been added: 
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Using these parameters, it's possible to make the following changes to the Z-Brackets: 
 
Location: Z-brackets can be located along the top bar, bottom bar, or left/right down bars. 
Interval: Z-brackets can be located at the ends or internally across the awning or both. 
Indent: Z-brackets can be indented from the left, right, top or bottom depending on the 
location. 
 
By adding two sets of Z-brackets and changing the location, interval and indent settings, we 
were able to add Z-brackets around all of the back frame members of the awning: 
 
 
 
 
 
 

 
 
 
 
 
 

Adding a Custom Accessory 

To add an accessory that is not in the list provided by Awning Composer, click on the Accessory 
Details arrow at the bottom of the Add Accessory window. 
 
A list of fields will be shown at the bottom of the window.  Note that quantity can be entered 
for individual items or for a box of items. Also note that only standard accessories can be 
displayed in the 3D view so these items are not shown on the awning frame. 
 
In the following example, we used this feature to add (4) ¼” x 4” lag bolts from Home Depot 
which are listed on the Bill of Materials: 
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Estimation 

Optional feature to calculate pricing as object is built 
 
Estimation is an optional feature available for most dynamic object awning styles.  To enable 
this feature, you need to register Awning Composer with a serial number that includes access 
to estimation.  The serial number will be available in your account on 
www.awningcomposer.com providing your company has purchased this option. 
 
This estimation feature provides instant quotes by determining material needed based on the 
current configuration of the dynamic objects in the scene window multiplied by your shop’s 
material and labor costs plus a profit margin. 
 

Estimation can be accessed by clicking on the inward facing arrow  along the right side of the 
3D view.  Once this button is clicked, an estimation panel will be displayed with various tabs 
containing estimation results and options. 
 
Estimation results can be displayed for a single awning, multiple different awnings or multiple 
quantities of the same awning.  The page layout system for printing has been enhanced to 
make it easier to create quotes and other documents that include estimation data.  Objects in 
the page layout such as textboxes can reference individual estimation values, which are then 
automatically filled out based on the current project.   
 
To make this process even easier, Awning Composer includes sample templates for customer 
quotes that can be customized as needed. 

How Estimation Works 

Estimation is based on the same dynamic object system used for visualization.  This provides a 
what-you-see-is-what-you-get result that takes into account the customization of the awning 
structure.  Changing the value of a part parameter (such as rafter spacing), will change the 
number of rafters on the object, which changes the amount of extrusion needed and also 
changes the amount of labor needed to install the rafters, which then changes the quote price. 
 
Note 1:  Making a part invisible does not affect the estimate.  The preferred method for 
removing a part from an object is to use one of the object parameters in the Object tab in the 
lower left corner.  If a parameter is not available to remove a part from the object, then the 
part can be manually deleted from the object.  To do this, right-click on the part in the 3D view 
and choose Delete.  Alternatively, select the part in the Object Parts list in the upper left corner, 
right-click on it, and choose Delete. 
 
Note 2:  If a part belongs to a group, then clicking on an individual part will highlight all of the 
parts within that group.  To delete a part that is a member of a group, grouping needs to be 
turned off.  To turn off grouping, go to the Options tab on the left side of the screen and turn 
off “Combine spaced parts” and “Combine related parts”.  This will result in more parts being 
shown in the Object Parts list with each part being identified individually instead of by its group 
name, making it possible to select and delete a single part.  
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Calculation Details 

The estimation formulas uses wholesale material and labor costs to calculate the actual cost of 
the project.  Wholesale material cost is defined as the price paid for the material including 
shipping.  Wholesale labor cost is defined as the hourly cost of labor including benefits.  The 
wholesale material and labor costs are added together to determine the actual project cost.  To 
determine the retail price for the customer, the actual project cost is multiplied by a 
profit/overhead factor as shown below: 
 
 
 
 
 
 
 

 

Labor Factors 

The amount of labor to build the frame and fabric is based on several factors.  Each of these 
factors was determined after doing a survey of companies across the country on how much 
time it took for them to build various kinds of lace-on/tech screw style awnings.   
 
Therefore the amount of labor being calculated may be too high for companies that build 
staple-on style awnings.  In all cases, we recommend that each company compare the amount 
of time being calculated to their actual shop build times over several jobs and carefully adjust 
these factors so they more accurately reflect reality in their shop.  The labor factors are: 
 
Mins per fabric panel Number of minutes to acquire, lay out, mark & cut a panel of fabric 
Mins per dome panel Number of additional minutes to lay out each dome panel between 

two curved rafters 
Seconds per inch/cm-
seams 

Number of seconds to sew or weld an inch or cm of panel, header or 
footer seams 

Secs per inch/cm-
separate SB/val 

Number of seconds to acquire, lay out, mark and cut an inch or cm 
of separate sign band/valance material 

Seconds per inch/cm-
braid 

Number of additional seconds (above normal seam time) to sew an 
inch/cm of braid onto bottom of valance 

Mins per valance cutout Number of minutes to lay out, mark and cut a single valance cutout 
Seconds per grommet Number of seconds to measure, mark, hole cut and press-in one 

grommet 
Mins per tube/extrusion 
length 

Number of minutes to acquire, measure, mark and course cut a 
length of pipe 

Minutes per joint Number of minutes to fine cut, weld and dress a joint 
Seconds per inch/cm-
curved 

Number of seconds to bend an inch or cm of curved tube or 
extrusion 

Minutes per pole Number of minutes to acquire, measure, mark, cut and install a pole 
Additional pole mins Number of additional minutes of pole labor to install footings, etc. 

Wholesale 
Material Cost 

Wholesale 
Labor Cost 

Actual Project 
Cost + = x Profit/Overhead 

Factor = Retail Price 
Quote 
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Profit / Overhead Factor 

Determining the correct profit/overhead factor is important to provide accurate quotes. 
Depending on the size and type of job you are quoting, there are several factors to consider.  
Based on a national survey, the range for this factor appears to be from 200% to 300% with an 
average value of 225%. 
 
The default value is set at 225%. Fabricators should look at this default as a starting point and 
adjust it based on the size of the job, job difficulty, etc. 
 
For example, a large job consisting of multiple awnings of the same style and size may allow for 
economies of scale which warrants a lower profit/overhead factor.  A small job which requires 
the same amount of sales time and management overhead as a larger job can justify setting a 
higher profit/overhead factor. 

Setting up Estimation Values 

Each tab in the estimation panel includes an Options section which is used to specify the 
wholesale material cost and labor rates.  Across all of the tabs, there are just over 40 options 
preloaded with average values based on a national survey.  These critical values must be 
reviewed and adjusted prior to using estimation to make sure they are accurate for your 
company.   
 
You can also set default values for each of these options. (Please see the prior section titled 
“Default Values Overview” for more information.)  These default values will be saved and used 
as a starting point for each new project.  You can also export and import default values and 
share them so that all employees are using the same values and therefore will end up with 
consistent quotes. 

When Options Are Used 

Just because you have reviewed and set values for each option does not mean that option will 
be used in every estimate.  As an example, "Seconds per inch/cm-curved" is only used when 
estimating an awning that has curved frame parts.  The same is true for "Secs per inch/cm-
separate SB/val" which will only be used for estimates on awnings that have a separate sign 
band or valance. 
 
It is important to review all of the option values to make sure they are accurate in case they are 
needed.  If a value of zero is entered for any option, then it will not contribute to the estimate 
even if it is required as part of an estimate.  

Quoting Recovers or Frame Only Jobs 

To quote a recover, turn off the “Include frame in estimate” option in the Frame tab.  To quote 
just the frame, turn off the “Include fabric in estimate” option in the Fabric tab. 
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Accessing the Estimation Panel 

To open the estimation panel, click on the black arrow located on the right side of the main 
window: 

 
 

This will open a panel with tabs labeled Frame, Fabric, Labor, Cost and Quote.  Each tab is 
divided into two sections: the top section displays estimation results and the bottom section 
displays options (e.g. labor rate) that you can set. 
 
At the top of each tab, there's a drop down box which can be used to select an individual object 
or total for all objects.  There's also a quantity field that can be used to easily estimate multiple 
awnings that are exactly the same.  Finally there's a details check box that can be used to show 
a detailed breakdown of how estimation totals were calculated. 
 

 
 
 
 
 
 
 
 
 
In the following pages, each of these estimation tabs will be shown along with information 
about the important areas within each tab. 
  

Turn this switch on 
to see more detailed 
info for each tab 

Enter quantity for 
multiple awnings with 
the same configuration 

Use this drop-down box 
to choose one awning or 
total for all awnings 
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Frame Tab 

The frame detail below is for a 6’W x 2’H x 2’D Traditional awning: 
 

 

Results 
Extrusion lengths and 

lacing bar lengths 
needed based on 
options set below 

Options 
Set these to match your 

shop process 

Parts List 
Calculated based on 

object dimensions and 
object parameters 

Options 
Uncheck for fabric 

only quote (recover) 

Options 
Select Paint or Powder 

Coating if needed 
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Fabric Tab 
The fabric detail below is for a 6’W x 2’H x 2’D Traditional lace-on awning with Wave 1 valance: 

 
  

Results  
Fabric, grommets and 

braid material 
needed based on 
options set below 

Options 
Set these to match 
your shop process 

Hover your mouse over any of these option names for a detailed explanation: 

 
 

Options 
Uncheck for frame 

only quote 

Options 
Turn on to run 

fabric horizontally 
(railroad fabric) 
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Labor Tab 

The labor detail below is for a 6’W x 2’H x 2’D Traditional lace-on awning with Wave 1 valance: 
 
 
 
 
 
 
 
 

 

  

Options  
Set these to typical 
average values for 

your process 

Results  
Frame and fabric 
labor calculated 

based on options set 
below 
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Staple-on vs. Tech Screw and Lace-on Awnings 

The factory default time values provided are based on average times for building lace-on 
and/or tech screw awnings.  At some point in the future, additional support for staple-on 
awnings will be added.  Until that support is added, fabricators who need to create estimates 
for staple-on awnings can make adjustments to the following fabric allowances and time factors 
as outlined below:  
 
Allowances 
The factory default allowances assume the awning is being sewn together and then laced-on or 
tech screwed to the frame.  For staple-on awnings, each panel must have enough fabric around 
the outside edge so that it can be held in place while staples are installed to hold the fabric in 
place. Therefore we recommend changing the default allowances as follows: 

 
- Seam Allowance: 3” 
- Footer Allowance: 3” 
- Top Bar Allowance: 3” 
- Footer Allowance: 3” 
- Down Bar Allowance: 3” 
- End Rafter Allowance: 3” 

 
The lacing strip and rafter lacing strip allowances do not need to be changed since these are 
only used when lacing bars are selected under the Lacing parameter tab. 
 
Minutes per panel 

The factory default for this time factor is 15 minutes per panel.  This is the amount of time 
needed to roll out the fabric, measure and mark the outer cut lines, measure and mark the 
sewing lines (where the fabric will be faced, hemmed or sewn to adjoining fabric panels) and 
cut the fabric panel to its exact size. 
 
For staple-on awnings, a fabric panel is cut a few inches larger than what is needed and then 
the panel is clamped to the frame, stapled into the frame and the excess fabric is cut off above 
the staples.  The amount of time needed for staple-on panels is much less because the marking 
and cutting process does not have to be as exact.  Therefore the Minutes per Panel should be 
reduced to between 5-7 minutes per panel for staple-on awnings. 
 
To make sure this number is accurate, keep track of the time needed to cut panels before the 
stapling process begins.   Compare the calculated Fabric Panel time to your actual panel time 
for several jobs before deciding what the correct Minutes per panel factor is for your shop. 
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Minutes per dome panel 

The factory default for this time factor is set to 10 minutes per panel.  This is very similar to the 
process described above except the fabric must be placed against the frame and marked down 
the rafters to create a banana-shaped fabric panel. 
 
Again for staple-on awnings, this process does not have to be as exact so the amount of time 
can be reduced to 4-6 minutes per panel.   But as above, we recommend comparing the 
calculated Dome Panel time to your actual panel time to determine the correct time factor. 
 
Seconds per inch/cm-seams 

The factory default for this time factor is set to 18 seconds per seam inch/centimeter.  In 
general, the amount of time that it takes to staple in fabric vs. sewing fabric seams is usually 
about the same. 
 
While stapling a seam may actually be a little faster than sewing that same length of seam, you 
have the additional steps of clamping the fabric in place and installing the inserts that must be 
accounted for. To determine if this factor should be adjusted, compare the Seam Labor 
calculated in Awning Composer to your actual staple time over the course of several jobs and 
then make adjustments if needed. 
 
Thread per inch/cm 
Enter a value of zero to prevent the calculation for thread from being added to the quote.  
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Cost Tab 

The cost detail below is for a 6’W x 2’H x 2’D Traditional lace-on awning with Wave 1 valance: 
 

 
  

Results 
Actual cost of 

material & labor with 
no profit/overhead 

Results 
Retail price of 

material & labor with 
profit/overhead 
factor applied 

Options 
Set cost equal to 

material cost 
including shipping   

Set labor rate equal 
to labor cost 

including benefits   

Set profit/overhead 
factor between e.g. 

200% and 300% 
depending on job 
size & complexity 
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Quote Tab 

The Quote tab is slightly different from the other tabs.  There's an option for price breakdown 
shown in the results section.  Enabling this option will show a price breakdown of fabric price, 
frame price and labor price.  This can be useful in situations where the customer is comparing 
the additional cost of using a premium fabric (i.e. stripes) vs a standard fabric (i.e. solid color). 
 
In the results section of the Quote tab, the retail price that was calculated in the Cost tab is 
shown.  By turning on the check boxes next to various options, other common items such as 
sales tax, installation fees, discounts, etc. can be added to the quote.  As these options are 
enabled, corresponding values for them will be displayed in the results section. 
 
In the example below, the price breakdown was not enabled, but a 7.25% sales tax and $100 
installation fee were added to the price of the awning: 
 

 
 

Results 
Object description 

based on dimensions 
and parameters. 

Results 
Price, sales tax and 
installation charge 

Price breakdown 
option shows fabric, 

frame and labor price 

Options 
Note sales tax and 
installation charge 
are enabled and an 
installation charge 

was entered 
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Creating a Quote 

Using the Page Layout feature to quickly generate a quote 
 

Awning Composer includes two sample quote templates which can be customized to look like 
your existing quote forms.  In addition to adding renderings, simple text, and images to the 
page, you can also add estimation values that are automatically filled in based on the current 
awnings in the scene. 
 
Estimation values are added to the quote by including some special text inside a text box that 
indicates which estimation values should be inserted.  For example the text {QTotInstalledPrice} 
is used to reference the total installed price for an awning.  Once the quote has been 
customized, it can be saved as a template (.acpl file) and then set as a default template that will 
be used as a starting point for each new project. 

Modifying a Quote Template 

Awning Composer includes a single object and multi-object quote template that are already set 
up to look like a standard quote.  The single-object template can be used for scenes with one 
awning and the multi-object template can be used for scenes with two or more awnings. 
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Each of the sample layouts come with placeholder company info (see circled items above) 
which should be changed or deleted.  To edit the layout: 
 

1) Click on File and then Render Image and use the crop controls to highlight the area 

around the awning. 

2) Click on Print and then click the Open Layout button.  Choose “Open sample layout” 

from the context menu and choose the single or multi-object sample template. 

3) Enter your company info in the upper left corner by clicking on the row to be changed 

and entering your data. 

4) Change the logo by right clicking on the MoreShade logo and selecting “Delete”.  Use 

the “Add image” button on the page layout tool bar to add your company logo. 

5) Change the tag line by right clicking on the text box that contains “Shade Sails and 

Awnings Since 1981” and selecting “Unlock” from the context menu.  Click in the text 

box to change the text to your company tag line.  (Note: The multi-object sample layout 

does not have a tag line because that space was used to show quote totals.) 

6) Click the Save Layout button to save these changes so they will be available the next 

time this template is opened. 

7) Click the Set Current Layout as Default button to set the modified layout as the default 

layout. 

Adding Estimation Values to a Template 

The sample quote template uses a combination of page layout objects to create a quote.  Image 

objects are used for static images like logos.  3D view objects are used to display the contents of 

the 3D view (e.g. a rendering of an awning).   A text box object is used to display the “Quote” 

text in the upper left hand corner.   Table objects are used to display all of the other 

information on the quote.   

 

Note that there are two types of text boxes that can be added.  One is called "Text box" and the 

other is called "Rich text box".   

 

“Text boxes” can only have one font style, one font size and one font color.  “Rich text boxes” 

can have mixed font styles, mixed font sizes and mixed font colors, and format text using 

paragraphs instead of lines. Other than these differences, both types of text boxes work 

basically the same but we recommend using regular text boxes whenever mixed font sizes and 

colors are not needed. 

 

Table and text box object can also have dynamic content such as estimation values that are 

automatically filled in and kept up to date as the scene changes. 
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After adding a text box, the following will be shown: 

 
After clicking in the text box to start editing it, a small toolbar will appear above it: 

 
Clicking on the first button in the toolbar will open the Insert Value window.  This window helps 

you insert dynamic values into the text box.  The following types of values can be inserted: 

 Basic values – Current date, current time, etc. 

 Object values – Object name, object height, object width, etc. 

 Estimator values – Quantity, quote description, total price, sales tax, etc. 

 

Once the type of value to be inserted has been found, double-click on it to insert it into the text 

box.  As an example, here are some of the value names for the Estimator values that were used 

on the sample quote:  {QTotPrice}, {QSalesTax}, {QInstallationCharge}, {QTotInstalledPrice} and 

this is what it looks like after those values have been inserted into a text box: 

 

 

 

 

 

 

 

 

 

After clicking in a table object, the tool bar will show three buttons.  The first button opens the 

Insert Value window.  The second button opens the Table Properties window which is described 

in the "Adjusting Page Layout Tables" section. 
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On the right side of the toolbar, there's a drop down box that lets you choose the source for 

dynamic values in this text box.  That is, when dynamic values are filled in automatically, where 

should they come from?  There are several possible choices: 

 

 (none) – Used for text boxes with no dynamic values (i.e. just straight text) 

 (single object) – Gets values for a single estimation-capable object in the scene, when 

the scene contains only one estimation-capable object. 

 (total for all objects) – Gets values that are added up for all objects in the scene, used 

for e.g. total costs. 

 (repeat for each object) – Cycles through each of the objects in the scene and gets 

values for each estimation-capable object. 

 [object name (e.g. Traditional)] – Gets values for a specific object in the scene.  This 

kind of option will be displayed as an individual object name like Traditional, Convex, 

etc. which you can select in order to get values for that specific object. 

 

In the example above, "(single object)" was selected in the drop down box.  This means that 

when there is a single object in the scene, then the values in the text box should be taken from 

that object. 

 

If the scene contains multiple objects that support estimation, "(single object)" won't use values 

from any of those objects.  You'll need to select each text box that you want to contain values 

for a single object and choose which object you want the values to come from. 

 

For example, to quote a price for a Traditional awning and a price for a Convex awning together 

on one quote, use a table object to define the values to be displayed (e.g. quantity, description, 

price, etc.).  Then in the drop down box, choose “repeat for each object”.  The table will now 

show quantity, description and price for the Traditional awning and then for the Convex 

awning. 

 

As you can see, the combination of using value names and selections in the drop down box 

provides a powerful tool for building custom quotes. 

Quoting Multiple Objects 

Awning Composer has the ability to quote multiple objects on a single quote.  This can be done 

in one of three ways:  1) By entering a quantity greater than one for multiple objects that are 

exactly the same; or 2) By adding two or more different objects to the scene; or 3) A 

combination of 1 and 2 above. 

 

When a quantity greater than one is entered for an object, estimation results will reflect this 

quantity.  Assuming a single Traditional awning is added to the scene, the estimation results will 
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show a quantity of 24 joints on the Frame tab.  If a quantity of 2 is entered for this awning, then 

the estimation results will show 24 x 2 = 48 joints in the Frame tab. 

 

If two different objects are added to the scene, then the estimation results can show the 

individual quantities associated with each object or the combined total for both objects.  As an 

example, assume a Traditional awning and an Open Traditional awning are added to the scene.  

With the Frame tab displayed, click on the Traditional object and then on the Open Traditional 

object and note that a quantity of 24 joints is shown for the Traditional awning and 12 joints is 

shown for the Open Traditional awning.  In the drop down box at the top of the estimation 

panel, select "(total for all objects)" and it will show the combined total of 36 joints for both 

objects. 

Multiple Object Material Savings 

At this time, the estimation system cannot calculate material savings across multiple awnings.  

At some point in the future, a net calculation for like material across multiple awnings is 

envisioned.  In the meantime, any material savings for multiple awnings must be calculated 

manually.  

Putting it all Together 

1) Before using doing your first estimate, be sure to look at the bottom of each estimation 

tab and review (and/or update) the default values for each of the options.  Once this 

review has been completed, you can start using the estimation results. 

2) Create an estimate by simply adding a dynamic object to the scene.  Then apply fabric, 

add a sign band (or valance), and adjust your frame parameters (e.g. rafter spacing, sign 

band height, etc.) 

3) Look at the estimation panel on the right side of the main window and review the 

results in each tab (shown at the top of the tab).  Make any adjustments needed in the 

Options section (at the bottom of the tab).  For example, in the Fabric tab, determine if 

you are going to run your fabric horizontally instead of vertically.  Note: For multiple 

awnings in the same scene, options do not have to be the same.  For example, a 

Traditional awning can have 46” fabric run vertically while a Convex awning can have 

60” fabric run horizontally and the system will calculate the yardage correctly. 

4) Look at the Quote tab and check off the options needed for this job.  For example, do 

you need to charge sales tax?  Is there a separate installation charge?  Are there 

additional charges for graphics or equipment rental? 

5) Once the review of the estimation tabs is complete, click on the File tab and then 

choose Print.  Use one of the default quote forms to print your estimate. 

Remember that the default quote forms can be modified.  You can add your own logo, tag lines 
or vary the quote data that is shown using the Page Layout vertical toolbar to the right of the 
print settings.  You can then save your layout and/or set it as the default. 
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Creating a Parts List  

Automatically generate a list of frame parts 
 
For most dynamic objects, Awning Composer can generate a list of parts with lengths and miter 
angles.   (Note: the parts list is now part of the estimation feature so estimation must be 
enabled for the parts list to be visible.)  While this list could be used as a starting point to create 
a “cut-list” for production, there are several potential problem areas: 
 

1) The awning in the scene must be configured the same way your shop normally builds 
awnings.  Each joint must have the correct Master option selected or the resulting part 
lengths may not match up to your standard design. 

2) Awning Composer does not yet support different sizes of extrusion within a single 
frame.  So all frame members must be the same square size (i.e. 1” x 1”, 2” x 2”, etc.) 

3) Awning Composer does not yet support birds-mouth joints so any components requiring 
these types of joints need to be calculated manually. 

4) Miter angles are calculated based on the square miter angle drop down box located just 
above the parts list.   

 
To see the parts list, open the estimation panel and look on the Frame tab.  The parts list will be 
shown for the currently select object.  If there are multiple objects in the scene and you want to 
see the parts lists for all of the objects, then select “(total for all objects)” in the drop down box 
at the top of the Frame tab. 
 

 
  

Shown below: Two Open Traditional 
awnings connected by an Open 
Traditional Square Corner awning. 

Parts list for the three awnings 



 

Awning Composer 5 Documentation Page 84 of 84 

Creating a Shop Drawing 

By using the page layout and parts list features, it's possible to produce a shop drawing that can 
be used for production.  Be sure to address each of the potential problem areas listed in the 
“Parts List” section to ensure that the awning created in Awning Composer matches the way 
awnings are built in your shop. 
 
Once your awning design has been completed, turn off the fabric visibility, add dimensions 
(optional), and then turn on “Show part numbering” in the Options section under Parameters in 
the Object tab.  Note that the multi-colored parts option is not currently used by parts lists in 
the page layout so the part numbering option is the best option to use right now. 
 
Click on the File tab and go to the “Render Image” page.  Use the crop feature to outline the 
area containing the frame.  Then go to the Print page and you will see the frame at the top of 
the page.  Position and size it as needed. 
 
Click on the “Add object to page” button at the bottom of the vertical Page Layout toolbar and 
then select Parts List from the context menu. Use the corner handles on the parts list table to 
adjust the size and location of the list.  Adjust the column widths by dragging the vertical lines 
in between the column headings.  Note that the lines in the rows below the column headers 
cannot be used to adjust column width. 
 

 

Frame colors and 
numbers on each part 

correspond to parts list. 

Column widths in parts 
list can be adjusted using 
the separator bars in the 

column header row. 
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